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INTRODUCTION TO MICROSOFT ACCESS 
 
A database is a collection of related information and has several objects such as a table, query, 
form or report. 

A table is a grouping of related data organized in fields (columns) and records (rows) on a 
datasheet. Many tables can be stored in a single database.  

A field is a column on a datasheet and defines a data type for a set of values in a table. For a 
mailing list a table might include fields for first name, last name, address, city, state, zip code, and 
telephone number. 

A record in a row on a datasheet and is a set of values defined by fields. In a mailing list table, 
each record would contain the data for one person as specified by the intersecting fields. Every 
record in a given table has the same fields in the same order 

The Database Window displays the various objects in an Access database. The default tables 
listing provides links for creating tables and will list all of the tables in the database when they have 
been added. 
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A table is displayed in multiple views. Design View is used to define the table initially and to specify 
the fields it will contain so that the data can be entered. 
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Datasheet View allows you to update, edit, and delete records.  

 

Adding Records 
Add new records to the table in datasheet view by typing in the record beside the asterisk (*) that 
marks the new record. You can also click the new record button at the bottom of the datasheet to 
skip to the last empty record. 

Editing records 
To edit records, simply place the cursor in the record that is to be edited and make the necessary 
changes. Use the arrow keys to move through the record grid. The previous, next, first, and last 
record buttons at the bottom of the datasheet are helpful in maneuvering through the datasheet. 

Deleting Records 
Delete a record on a datasheet by placing the cursor in any field of the record row and select 
Edit|Delete Record from the menu bar or click the Delete Record button on the datasheet toolbar. 

Adding and Deleting Columns 
Although it is best to add new fields (displayed as columns in the datasheet) in design view 
because more options are available, they can also be quickly added in datasheet view. Highlight the 
column that the new column should appear to the left of by clicking its label at the top of the 
datasheet and select Insert|Column from the menu bar. 

Resizing Rows and Columns 
The height of rows on a datasheet can be changed by dragging the gray sizing line between row 
labels up and down with the mouse. By changing the height on one row, the height of all rows in the 
datasheet will be changed to the new value. 
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Column width can be changed in a similar way by dragging the sizing line between columns. 
Double click on the line to have the column automatically fit to the longest value of the column. 
Unlike rows, columns on a datasheet can be different widths. More exact values can be assigned 
by selecting Format|Row Height or Format|Column Width from the menu bar. 

Finding Data in a Table 
Data in a datasheet can be quickly located by using the Find command. 

 
 
Replace 
The replace function allows you to quickly replace a single occurrence of data with a new value or 
to replace all occurrences in the entire table. 

 
 
Check Spelling and AutoCorrect 
The spell checker can be used to flag spelling errors in text and menu fields in a datasheet. Select 
Tools|Spelling from the menu bar to activate the spell checker and make corrections just as you 
would using Word or Excel. The AutoCorrect feature can automatically correct common spelling 
errors such as two INitial CApitals, capitalizing the first letter of the first word of a sentence, and 
anything you define. Select Tools|AutoCorrect to set these features. 
 
Print a Datasheet 
Datasheets can be printed by clicking the Print button on the toolbar or select File|Print to set more 
printing options. 
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Sorting and filtering  

Sorting and filtering allow you to view records in a table in a different way either by reordering all of 
the records in the table or view only those records in a table that meet certain criteria that you 
specify. 

 Sorting 
You may want to view the records in a table in a different order than they appear such as sorting by 
a date or in alphabetical order, for example. Follow these steps to execute a simple sort of records 
in a table based on the values of one field: 

1. In table view, place the cursor in the column that you want to sort by.  
2. Select Records|Sort|Sort Ascending or Records|Sort|Sort Descending from the menu 

bar or click the Sort Ascending or Sort Descending buttons on the toolbar.  

To sort by more than one column (such as sorting by date and then sorting records with the same 
date alphabetically), highlight the columns by clicking and dragging the mouse over the field labels 
and select one of the sort methods stated above. 
 

 Filter by Selection 
This feature will filter records that contain identical data values in a given field such as filtering out 
all of the records that have the value "Smith" in a name field. To Filter by Selection, place the cursor 
in the field that you want to filter the other records by and click the Filter by Selection button on the 
toolbar or select Records|Filter|Filter By Selection from the menu bar. In the example below, the 
cursor is placed in the City field of the second record that displays the value "Ft. Myers" so the 
filtered table will show only the records where the city is Ft. Myers. 
 

 
 

 Filter by Form 
If the table is large, it may be difficult to find the record that contains the value you would like to filter 
by so using Filter by Form may be advantageous instead. This method creates a blank version of 
the table with drop-down menus for each field that each contains the values found in the records of 
that field. Under the default Look for tab of the Filter by Form window, click in the field to enter the 
filter criteria. To specify an alternate criteria if records may contain one of two specified values, click 
the Or tab at the bottom of the window and select another criteria from the drop-down menu. More 
Or tabs will appear after one criteria is set to allow you to add more alternate criteria for the filter. 

After you have selected all of the criteria you want to filter, click the Apply Filter button on the 
toolbar. 
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The following methods can be used to select records based on the record selected by that do not 
have exactly the same value. Type these formats into the field where the drop-down menu appears 
instead of selecting an absolute value. 
 
 

Filter by Form 

Format Explanation 

Like "*Street" Selects all records that end with "Street" 

<="G" Selects all records that begin with the letters A through G 

>1/1/00 Selects all dates since 1/1/00 

<> 0 Selects all records not equal to zero  
 
 
Saving A Filter 
The filtered contents of a table can be saved as a query by selecting File|Save As Query from the 
menu bar. Enter a name for the query and click OK. The query is now saved within the database. 
 

 
 

 Remove a filter 

To view all records in a table again, click the depressed Apply Filter toggle button on the toolbar. 
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Table Relationships 
To prevent the duplication of information in a database by repeating fields in more than one table, 
table relationships can be established to link fields of tables together. Follow the steps below to set 
up a relational database:  

1. Click the Relationships button on the toolbar.  
2. From the Show Table window (click the Show Table button on the toolbar to make it 

appear), double click on the names of the tables you would like to include in the 
relationships. When you have finished adding tables, click Close. 

 

 

3. To link fields in two different tables, click and drag a field from one table to the 
corresponding field on the other table and release the mouse button. The Edit 
Relationships window will appear. From this window, select different fields if necessary 
and select an option from Enforce Referential Integrity if necessary. These options give 
Access permission to automatically make changes to referential tables if key records in one 
of the tales is deleted. Check the Enforce Referential Integrity box to ensure that the 
relationships are valid and that the data is not accidentally deleted when data is added, 
edited, or deleted. Click Create to create the link. 
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4. A line now connects the two fields in the Relationships window. 

 

 

 

5. The datasheet of a relational table will provide expand and collapse indicators to view 
subdatasheets containing matching information from the other table. In the example below, 
the student address database and student grade database were related and the two can be 
shown simultaneously using the expand feature. To expand or collapse all subdatasheets 
at once, select Format|Subdatasheet|Expand All or Collapse All from the toolbar.  
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Laboratory Work:  INTRODUCTION TO MICROSOFT ACCESS: WHAT IS A DATABASE? 

Objectives 

• Define the terms field, record, table, and database. 
• Start Microsoft Access; describe the Database window and the objects in an Access 

database. 
• Add, edit, and delete records within a table; use the Find command to locate a specific 

record. 
• Describe the record selector; explain when changes are saved to a database. 
• Explain the importance of data validation in table maintenance. 
• Apply a filter (by form or by selection) to a table; sort a table on one or more fields. 

EXERCISE 1 
Open the Employee Database. Be sure to remove any filters that are in effect, and then implement 
the following transitions: 
 
1. Delete the record for Kelly Marder. 
2. Change Pamela Milgrom's salary to $59,500. 
3. Use the Replace command to change all occurrences of "Manager" to "Supervisor". 
4. Open the Employee Census Report as shown in the following figure after making the changes 

in parts (1) through (3). 
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EXERCISE 2 
Open the Bookstore database and modify the database to accommodate the following: 
 

• Add the book Exploring Microsoft Office 2000 Vol II (ISBN: 013-011100-7) by 
Grauer/Barber, published in 1999 by Prentice Hall, selling for $45.00. 

• Change the price of Memory Management for All of Us to $29.95. 
• Delete The Presentation Design Book. 
• Open the All Books Report as shown in the following figure after these changes have been 

made. 
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EXERCISE 3 
Open the Super Bowl database.  
 
1. On the Objects bar, double-click the Super Bowl table to open it in the Datasheet view. 
 

 
 

 
2. The data has to be Sorted. Click anywhere in the Year field, then click the Descending Sort 

 button to display the most recent Super Bowl first. 

3. Select the Winner in any year that the AFC won. Click the Filter by Selection  button to 
display only those records (the years in which the AFC won the game). 

4. Click the Remove Filter  button. Select any year in which the NFC won, then click the 

Filter by Selection  button to display the years in which the NFC won. Remove the filter. 
5. Create one additional filter (for example, the years in which your favorite team won the big 

game).  
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TABLES 

A table stores information in a row-column format a database similar to the way an Excel worksheet 
stores information in a workbook. Access provides three ways to create a table for which there are 
icons in the Database Window. Double-click on the icons to create a table. 

 
The Database Window 

• Create table in Design view will allow you to create the fields of the table. This is the most 
common way of creating a table and is explained in detail below.  

 
• Create table using wizard will step you through the creation of a table.  

 
 
• Create table by entering data will give you a blank datasheet with unlabelled columns that 

looks much like an Excel worksheet. Enter data into the cells and click the Save button. 
You will be prompted to add a primary key field. After the table is saved, the empty cells of 
the datasheet are trimmed. To rename the fields with more descriptive titles that reflect the 
content of the fields, select Format |Rename Column from the menu bar or highlight the 
column, right-click on it with the mouse, and select Rename Column from the shortcut 
menu.  

 
Create a Table in Design View 
Design View will allow you to define the fields in the table before adding any data to the datasheet. 
The window is divided into two parts: a top pane for entering the field name, data type, and an 
option description of the field, and a bottom pane for specifying field properties. 
 

• Field Name - This is the name of the field and should represent the contents of the field 
such as "Name", "Address", "Final Grade", etc. The name can not exceed 64 characters in 
length and may include spaces.  

 
• Data Type is the type of value that will be entered into the fields. 

o Text - The default type, text type allows any combination of letters and numbers up 
to a maximum of 255 characters per field record. 

o Memo - A text type that stores up to 64,000 characters. 

o Number - Any number can be stored. 

o Date/Time - A date, time, or combination of both. 

o Currency - Monetary values that can be set up to automatically include a dollar 
sign ($) and correct decimal and comma positions. 
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o AutoNumber - When a new record is created, Access will automatically assign a 
unique integer to the record in this field. From the General options, select 
Increment if the numbers should be assigned in order or random if any random 
number should be chosen. Since every record in a datasheet must include at least 
one field that distinguishes it from all others, this is a useful data type to use if the 
existing data will not produce such values. 

o Yes/No - Use this option for True/False, Yes/No, On/Off, or other values that must 
be only one of two. 

o OLE Object - An OLE (Object Linking and Embedding) object is a sound, picture, 
or other object such as a Word document or Excel spreadsheet that is created in 
another program. Use this data type to embed an OLE object or link to the object in 
the database. 

o Hyperlink - A hyperlink will link to an Internet or Intranet site, or another location in 
the database. The data consists of up to four parts each separated by the pound 
sign (#): DisplayText#Address#SubAddress#ScreenTip. The Address is the only 
required part of the string. Examples: 

Internet hyperlink example:  Cankaya Univ. Home Page    #http://www.cankaya.edu.tr# 

• Description (optional) - Enter a brief description of what the contents of the field are.  
 
• Field Properties - Select any pertinent properties for the field from the bottom pane.  

 
 

Field Properties 
Properties for each field are set from the bottom pane of the Design View window. 

• Field Size is used to set the number of characters needed in a text or number field. The 
default field size for the text type is 50 characters. If the records in the field will only have 
two or three characters, you can change the size of the field to save disk space or prevent 
entry errors by limiting the number of characters allowed. Likewise, if the field will require 
more than 50 characters, enter a number up to 255. The field size is set in exact characters 
for Text type, but options are give for numbers:  

o Byte - Positive integers between 1 and 255  

o Integer - Positive and negative integers between -32,768 and 32,768  

o Long Integer (default) - Larger positive and negative integers between -2 billion and 
2 billion.  

o Single - Single-precision floating-point number  

o Double - Double-precision floating-point number  

o Decimal - Allows for Precision and Scale property control  

• Format conforms the data in the field to the same format when it is entered into the 
datasheet. For text and memo fields, this property has two parts that are separated by a 
semicolon. The first part of the property is used to apply to the field and the second applies 
to empty fields. 
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Text and memo format. 

Text Format 
Format Datasheet Entry Display Explanation 

@@@-@@@@ 1234567 123-4567 @ indicates a required 
character or space 

@@@-@@@& 123456 123-456 & indicates an optional 
character or space 

< HELLO hello < converts characters to 
lowercase 

> hello HELLO > converts characters to 
uppercase 

@\! Hello Hello! \ adds characters to the end 

@;"No Data Entered" Hello Hello   

@;"No Data Entered" (blank) No Data Entered    

 

Number format. Select one of the preset options from the drop down menu or construct a 
custom format using symbols explained below: 

Number Format 
Format Datasheet Entry Display Explanation 

###,##0.00  123456.78 123,456.78

$###,##0.00 0 $0.00 

0 is a placeholder that displays a digit or 0 if 
there is none. 
# is a placeholder that displays a digit or 
nothing if there is none. 

###.00% .123 12.3% % multiplies the number by 100 and added a 
percent sign  

 
 

Currency format. This formatting consists of four parts separated by semicolons: 
format for positive numbers; format for negative numbers; format for zero values; format for Null 
values. 

Currency Format 
Format Explanation 

$##0.00;($##0.00)[Red];$0.00;"none" Positive values will be normal currency format, 
negative numbers will be red in parentheses, zero 
is entered for zero values, and "none" will be 
written for Null values.  
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Date format. In the table below, the value "1/1/01" is entered into the datasheet, and the following 
values are displayed as a result of the different assigned formats. 

 

Date Format 
Format Display Explanation 

dddd","mmmm d","yyyy Monday, January 1, 2001 dddd, mmmm, and yyyy print the full 
day name, month name, and year 

ddd","mmm ". " d", '"yy Mon, Jan. 1, '01 ddd, mmm, and yy print the first 
three day letters, first three month 
letters, and last two year digits  

"Today is " dddd Today is Monday   

h:n:s: AM/PM 12:00:00 AM "n" is used for minutes to 
avoid confusion with months  

 
Yes/No fields are displayed as check boxes by default on the datasheet. To change the formatting 
of these fields, first click the Lookup tab and change the Display Control to a text box. Go back to 
the General tab choices to make formatting changes. The formatting is designated in three sections 
separated by semicolons. The first section does not contain anything but the semicolon must be 
included. The second section specifies formatting for Yes values and the third for No values. 

Yes/No Format 
Format Explanation 

;"Yes"[green];"No"[red] Prints "Yes" in green or "No" in red 

 

Default Value - There may be cases where the value of a field will usually be the same for all 
records. In this case, a changeable default value can be set to prevent typing the same thing 
numerous times. Set the Default Value property. 

Primary Key 
Every record in a table must have a primary key that differentiates it from every other record in the 
table. In some cases, it is only necessary to designate an existing field as the primary key if you are 
certain that every record in the table will have a different value for that particular field. A social 
security number is an example of a record whose values will only appear once in a database table. 
Designate the primary key field by right-clicking on the record and selection Primary Key from the 
shortcut menu or select Edit|Primary Key from the menu bar. The primary key field will be noted 
with a key image to the left. To remove a primary key, repeat one of these steps. 
If none of the existing fields in the table will produce unique values for every record, a separate field 
must be added. Access will prompt you to create this type of field at the beginning of the table the 
first time you save the table and a primary key field has not been assigned. The field is named "ID" 
and the data type is "autonumber". Since this extra field serves no purpose to you as the user, the 
autonumber type automatically updates whenever a record is added so there is no extra work on 
your part. You may also choose to hide this column in the datasheet as explained on a later page in 
this tutorial. 
 
Indexes 
Creating indexes allows Access to query and sort records faster. To set an indexed field, select a 
field that is commonly searched and change the Indexed property to Yes (Duplicates OK) if 
multiple entries of the same data value are allowed or Yes (No Duplicates) to prevent duplicates. 
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Field Validation Rules 
Validation Rules specify requirements (change word) for the data entered in the worksheet. A 
customized message can be displayed to the user when data that violates the rule setting is 
entered. Click the expression builder ("...") button at the end of the Validation Rule box to write the 
validation rule. Examples of field validation rules include <> 0 to not allow zero values in the record, 
and ??? to only all data strings three characters in length. 
 
Input Masks 
An input mask controls the value of a record and sets it in a specific format. They are similar to the 
Format property, but instead display the format on the datasheet before the data is entered. For 
example, a telephone number field can be formatted with an input mask to accept ten digits that are 
automatically formatted as "(999) 888-7777". The blank field would look like (___) ___-____. An an 
input mask to a field by following these steps: 

1. In design view, place the cursor in the field that the input mask will be applied to.  
2. Click in the white space following Input Mask under the General tab.  
3. Click the "..." button to use the wizard or enter the mask, (@@@) @@@-@@@@, into the 

field provided. The following symbols can be used to create an input mask from scratch: 

Input Mask Symbols 

Symbol Explanation 

A Letter or digit 

0 A digit 0 through 9 without a + or - sign and with blanks displayed as 
zeros 

9 Same as 0 with blanks displayed as spaces 

# Same as 9 with +/- signs 

? Letter 

L Letter A through Z 

C or & Character or space 

< Convert letters to lower case 

> Convert letters to upper case  
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Laboratory work:  CREATING A TABLE 

Objectives 

• To use the Table Wizard to create a table 
• To add and delete fields in an existing table 
• To establish an input mask and validation rule for fields within a table 
• To switch between the Design and Datasheet views of a table 

 

EXERCISE 4 

 
STEP 1 : Create a New Database 

¾ Click the Start button to display the Start menu. Click the Programs menu, then click 
Microsoft Access to start the program. 

¾ You should see the Microsoft Access dialog box as shown on 
the left side. Click the option button to create a new database 
using a Blank Access Database. Click OK. 

¾ Click the drop-down arrow on the Save in: list box. Click the 
appropriate drive (drive C or drive A), depending on the location 
of your data. Double click the Exploring Access folder to 
make it the active folder. 

 

¾ Click in the File Name text box and drag to select db1. Type My First Database as the name 
of the database you will create. Click the Create button. 

 

 

STEP 2 : Create the Table 

¾ The database window for My First Database should appear on your monitor. The Tables 
button is selected by default. 
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¾ Click and drag an edge or border of the Database window to change its size. Click and drag the 

title bar of the Database window to change its position on the desktop. 

¾ Click the New button to display the New Table dialog box. Click (select) Table Wizard in the 
New Table dialog box, then click OK to start the Table Wizard. 

 

 
 

STEP 3: The Table Wizard 

¾ If necessary, click the Business Option button. Click the down arrow on the Sample Tables 
list box to scroll through the available business tables. Click (select) Students within the list of 
sample tables. The tables are not in alphabetical order, and the Students table is found near the 
very bottom of the list. 

¾ The StudentID field is already selected in the Sample Fields list box. Click the > button to 
enter this field in the list of fields for the new table. 

¾ Enter the additional fields for the new table by selecting the field and clicking the > button. The 
fields to enter are: FirstName, LastName, Address, City, and StateOrProvince. 

¾ Click the Rename Field command button after the adding the StateOrProvince field to display 
the Rename Field dialog box. Enter State to shorten the name of this field. Click OK. 

¾ Add PostalCode and PhoneNumber as the last two fields in the table. Click the Next 
command button when you have entered all the fields. 
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STEP 4 :  

¾ The next screen in the Table Wizard asks you to  name the table and determine the primary 
key. 

¾ Accept the Wizard’s suggestion of Students as the name of the table. 

¾ Make sure that the option button Yes, set a primary key for me is selected. 

¾ Click the Next command button to accept both of these options. 

 
 

¾ The final screen in the Table Wizard asks you what to do next. 

¾ Click the option button to Modify the table design. 
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¾ Click the Finish command button. The Students table should appear on your monitor. Pull 
down the File menu and click Save to save the table. 

 
 
STEP 5 : Add the Additional Fields 

¾ Click the cell immediately below the last field in the table (PhoneNumber). Type BirthDate. 
¾ Press the Tab key to move to the Data Type column. Click the down arrow on the drop-down 

list box. Click Date/Time.  
¾ Add the remaining fields to the Students table. Add Gender as a text field. Add Credits as a 

Number field. Add Points as a Number field. 
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STEP 6 : Change the Primary Key 

¾ Point to the first field in the table and click the right mouse button to display the shortcut 
menu. Click Insert Rows. 

¾ Click the Field Name column in the newly inserted row. Type SSN (for social security number) 
as the name of the new field. Press enter. The data type will be set to Text by default. 

¾ Click the Required box in the Properties area. Click the drop-down arrow and select Yes. 
¾ Click in the Field Name column for SSN, then click the Primary Key button on the Table 

Design toolbar to change the primary key to social security number. The primary key symbol 
has moved to SSN. 

¾ Point to the StudentID field in the second row. Click the right mouse button to display the 
shortcut menu. Click Delete Rows to remove this field from the table definition. Save the table. 

 
 
STEP 7 : Add an Input Mask 

¾ Click the Field selector column for SSN. Click the Input Mask box in the Properties area. 
¾ Click the Build button to display the Input Mask Wizard. Click Yes if asked whether to save the 

table. Click Social Security Number in the Input Mask Wizard dialog box. 
¾ Click the Try It text box and enter a social secyrity number to see how the mask works. If 

necessary, press the left arrow key until you are at  the beginning of the text box, then enter a 
social security number (digits only). Click the Finish command button to accept the input 
mask. 
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¾ Click the field selector column for BirthDate, then follow the steps detailed above to add an 
input mask. (Choose the Short Date format.) Click Yes if asked whether to save the table. 
Save the table. 

 
STEP 8 : Change the Field Properties 

¾ Click the field selector column for the FirstName field: 
• Click the Field Size box in the Properties area and change the field size to 25. 
• Click the Required box in the Properties area. Click the drop-down arrow and select Yes. 

¾ Click the field selector column for the LastName field: 
• Click the Field Size box in the Properties area and change the field size to 25. 
• Click the Required box in the Properties area. Click the drop-down arrow and select Yes. 

¾ Click the field selector column for the State field: 
• Click the Field Size box in the Properties area and change the field size to 2. 
• Click the Format box in the Properties area. Type a  > sign to display the data in 

uppercase. 

¾ Click the field selector column for the Credits field: 
• Click the Field Size  box in the Properties area, click the drop-down arrow to display the 

available field sizes, then click Integer. 
• Click the Default Value box in the Properties area. Delete the 0. 

¾ Click the field selector column for the Points field: 
• Click the Field Size  box in the Properties area, click the drop-down arrow to display the 

available field sizes, then click Integer. 
• Click the Default Value box in the Properties area. Delete the 0. Save the table. 
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STEP 9 : Add a Validation Rule 

¾ Click the field selector column for the Gender field. Click the Field Size  box and change the 
field size to 1. 

¾ Click the Format box in the Properties area. Type a  > sign to display the data entered in 
uppercase. 

¾ Click the Validation Rule box. Type   “M” or “F”   to accept only these values on data entry. 

¾ Click the Validation Text box. Type  You must specify M or F. Save the table. 

 

 

 

STEP 10 : The Datasheet View 

¾ Pull down the View menu and click Datasheet View to change to the Datasheet view. 

¾ The insertion point is automatically set to the first field of the first record. 

¾ Type  111111111  to enter the social security number for the first record. (The input mask will 
appear as soon as you enter the first digit.) 

¾ Press the Tab key, the right arrow key, or the enter key to move to the FirstName field. Enter 
the data for Brad Pitt and make up data for other fields. 

¾ Scrolling takes place automatically as you move within the record. 

¾ Enter data for the two other students, but enter deliberately invalid data to experiment with the 
validation capabilities built into Access. Save the table. 
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FORMS 
 
A form provides a user-friendly way to enter and display the data stored in a table. AutoForms and 
the Form Wizard are easy ways to create a form. One advantage of using a form (as opposed to 
entering records in the Datasheet view) is that you can see all of the fields in a single record without 
scrolling. A second advantage is that a form can be designed to resemble a paper form.  
 
A form has two views; The Form view displays the completed form and is used to enter or modify 
the data in the underlying table.  
 

 
 
                         

The Form view 
 
 
The Design view ids used to create or modify the form.  
 

  
  
                        

Bound control Unbound control 

The Design view 
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All forms contain objects that called controls that accept and display data, perform a specific 
action, decorate a form, or add descriptive information. There are three types of controls: bound, 
unbound and calculated.  
 
A bound control ( such as the text boxes in the design view above) has a data source (a field in 
the underlying table) and is used to enter or modify the data in that table.  
 
An unbound control has no data source. Unbound controls are used to display titles, labels, lines, 
graphics, or pictures. Every bound control is associated with an unbound control (or label to identify 
the control).  
 
A calculated control has its data source an expression rather than a field. An expression is a 
combination of operators (+, -, * and /) field names, constants, and/or functions.  
 
Properties 
 
A property is a characteristic of an object that determines how the object looks and behaves. Each 
control in a form has its own set of properties, just as every field in a table has its own set of 
properties. The properties for a control are displayed in a property sheet.  
 
AutoForms and the Form Wizard 
 
The easiest way to create a form is by selecting one of several predefined AutoForms. Double click 
the Columnar AutoForms, for example, and you are presented with a form that contains all of the 
fields in the underlying table or query.  
 
The Form Wizard gives you greater flexibility because you can select the fields you want and/or 
choose a different style from the default style provided by the AutoForm. The Wizard asks you a 
series of questions, then build the form according to your answers. 
 

 
 

Click Form Wizard 

Select Table 
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Modifying a Form 

ou can customize the form, by adding other controls, such as adding a calculated field, and/or 

 

ach control can be moved or sized by selecting the control, then clicking and dragging to resize 
 

 
Y
modify the controls that were created by the Wizard.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click >> to select all fields  

 
 
 
 
 
 Click Next 
 
 
 
E
the control or position it elsewhere on the form.  You can also change the properties of the control
through buttons on the various toolbars or by displaying the property sheet for the control and 
changing the appropriate property.  
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Laboratory work:  CREATING A FORM 

Objectives 

• To use the Form Wizard to create a form 
• To move and size controls within a form 
• To use the completed form to enter data into the associated table 

EXERCISE 5 
STEP 1 : Open the Existing Database & The Form Wizard 

¾ Start Access. Select My First Database from the list of recently opened databases, then click 
OK. 

¾ Click the Forms button in the Database window. Click the New command button to display the 
New Form dialog box. 

¾ Click Form Wizard in the list box. Click the drop-down arrow to display the available tables and 
queries in the database on which the form can be based. 

¾ You should see the dialog box which displays all of the fields in the Students table. Click the >> 
button to enter all of the fields in the table on the form. Click the Next command button. 

 

 
 

¾ The Columnar layout is already selected. Click the Next command button. 

¾ Click Industrial as the style for your form. Click the Next command button. 

¾ The Form Wizard asks you for the title of the form and what you want to do next. 

• The Form Wizard suggests Students as the title of the form. Keep this entry. 

• Click the option button to Modify the form’s design. 

¾ Click the Finish command button to display the form in Design view.  
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STEP 3 : Move the Controls 

¾ If necessary, click the Maximize button so that the form takes the entire screen. The Form 
Wizard has arranged the controls in columnar format, but you need to rearrange the controls. 

¾ Click the LastName control to select the control and display the sizing handles. (Be sure to 
select the text box and not the attached label.) Click and drag the border of the control (the 
pointer changes to a hand) so that the LastName control is on the same line as the FirstName 
control. Use the grid to space and align the controls. 

¾ Click and drag the Address control under the FirstName control. Click and drag the border of 
the form to 18 cm. so that the City, State, and PostalCode controls will fit on the same line. 

¾ Click and drag the State control so that it is next to the City control, then click and drag the 
PostalCode control so that it is on the same line as the other two. Press and hold the Shift key 
as you click the City, State, and PostalCode controls to select all three, then click and drag the 
selected controls under the Address control. 

¾ Place the controls for PhoneNumber, BirthDate, and Gender on the same line. Move the 
controls under City, State, and PostalCode. Place the controls for Credits and Points on the 
same line. Move the controls under PhoneNumber. 

¾ Fine-tune the form as necessary to make it more attractive. Move LastName to align it with 
State. Also you may make the SSN and PostalCode controls smaller. Pull down the File menu 
and click Save to save the form. 
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STEP 4 : Add a Calculated Control (GPA) 

¾ Click the Text box tool in the Toolbox. The mouse pointer changes to a tiny crosshair with a text 
box attached. 

¾ Click and drag in the form where you want the text box (the GPA control) to go. Release the 
mouse. You will see an Unbound control and an attached label containing a field number ( for 
ex. Text24). 

¾ Click in the text box of the control. The word Unbound will disappear, and you can enter an 
expression  = [Points]/[Credits]   to calculate a student’s GPA. Do not be concerned if you 
cannot see the entire entry as scrolling will take place as necessary. You must enter the field 
names exactly as they were defined in the table. 

¾ Select the attached label (Text24), then click and drag to select the text in the attached label. 
Type GPA as the label for this control and press enter. Size the text box appropriately for GPA. 
Size the bound control as well. Move either control as necessary. Click the Save button. 

 
STEP 5 : Modify the Property Sheet 

¾ Point to the GPA control and click the right mouse button to display a shortcut menu. Click 
Properties to display the Properties dialog box. 

¾ If necessary, click the All tab. The Control Source text box contains the entry  = 
[Points]/[Credits]    from the preceding step. 

¾ Click the Name text box. Replace the original name (Text24) with GPA. Click the Format box. 
Click the drop-down arrow, then scroll until you can select Fixed. Click the box for the Decimal 
Places. Click the drop-down arrow and select 2 as the number of decimal places. 

¾ Close the Properties dialog box to accept these settings and return to the form. 
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STEP 6 : Create the Form Header 

¾ Click and drag the line separating the border of the Form Header and Detail to provide space 
for a header. 

¾ Click the Label tool on the Toolbox toolbar (the mouse pointer changes to a cross hair 
combined with the letter A). Click and drag the mouse pointer to create a label within the 
header. The insertion point is automatically positioned within the label. 

¾ Type Student Information Form. Do not be concerned about the size or alignment of the text 
at this time. Click outside the label when you have completed the entry, then click the control to 
select it. 

¾ Click the drop-down arrow on the Font Size list box on the Formatting toolbar. Click 18. The 
size of the text changes to the larger point size. 

¾ Click the drop-down arrow next to the Special Effect button on the Formatting toolbar to 
display the available effects. Click the Raised button to highlight the label. Click outside the 
label to deselect it. Click the Save button to save the form. 

 
 
STEP 7 : Add the Date 

¾ Click the Textbox tool on the Toolbox toolbar. The mouse pointer changes to a tiny crosshair 
with a text box attached. Click and drag in the form where you want the text box for the date, 
then release the mouse. 
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¾ You will see an Unbound control and the attached label containing a number (Text27). Click in 
the text box, and the word Unbound will disappear. Type  =Date( ). Click the attached label. 
Press the Del key to delete the label. 

 
 

STEP 9 : The Form View 

¾ Click the View button to switch to the Form view. You will see the first record in the  table that 
was created in the previous exercise. 

¾ Click the New Record button to move to the end of the table to enter a new record. Enter data 
for yourself. The record selector symbol changes to a pencil as you begin to enter data. 

¾ Press the Tab key to move from one field to the next within the form. All properties (masks and 
validation) have been inherited from the Students table created in the first exercise. 

¾ Pull down the File menu and Close the form. Click Yes if asked to save the changes to the 
form. Pull down the File menu and Close the database. 
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Laboratory work:  CREATING A MORE SOPHISTICATEDFORM 

Objectives 

• To add fields to an existing table 
• To use the Lookup Wizard to create a combo box 
• To add controls to an existing form to demonstrate inheritance 
• To add command buttons to a form 

EXERCISE 6 

STEP 1 : Modify the Table 
¾ Open My First Database that we have been using throughout the previous works. If necessary, 

click the Tables button in the Database window. The Students table is already selected since 
that is the only table in the database. 

¾ Click the Design command button to open the table in Design view. Maximize the window. 

¾ Click the Field Name box under Quality Points. Enter FinancialAid as the name of the new 
field. Press the tab, or right arrow key to move to the Data Type column. Specify the Type as 
a Yes/No field. 

¾ Click the Field Name box on the next row. Type Campus (There is no need to specify the Data 
Type since Text is the default). 

¾ Press the down arrow key to move to the Field Name box on the next row. Enter Major. Press 
the tab, or right arrow key to move to the Data Type column. Click the drop-down arrow to 
display the list of data types. Click Lookup Wizard. 

 
 

STEP 2 : The Lookup Wizard 

¾ The first screen in the Lookup Wizard asks how you want to look up the data. Click the option 
button that indicates I will type in the values that I want. Click Next.  
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¾ The Number of columns is already entered as one. Click the text box to enter the first major. 
Type Business. Press Tab or down arrow key ( do not press the enter key) to enter the next 
major. 

¾ Complete the entries as Communication, Education, Engineering, Liberal Arts. Click Next. 
The Wizard asks for a label to identify the column (Major is already entered). Click Finish to 
exit the Wizard and return to the Design View. Click the Save button to save the table. Close 
the table. 

 
STEP 3 : Add the New Controls 

¾ Click the Forms button in the Database window. If nexessary, click the Students form to select 
it. 

¾ Click the Design command button to open the form from the previous exercise. If necessary, 
Click the Maximize button so that the form takes the entire window. 

¾ Pull down the View menu. Click Field List to display the field list for the table on which the 
form is based. You can move and size the field list just like any other Windows object. 

¾ Fields can be added to the form from the field list in any order. Click and drag the Major field 
from the field list to the form. The Major control is created as a combo box because of the 
lookup list in the underlying table.  

¾ Click and drag the FinancialAid field from the list to the form. The FinancialAid control is 
created as a check box because FinancialAid is a Yes/No field in the underlying table. Save the 
form. 

 

STEP 4 : Create an Option Group 

¾ Click the Option Group button on the Toolbox toolbar. The mouse pointer changes to a tiny 
crosshair attached to an option group icon when you point anywhere in the form. Click and 
drag in the form where you want the option group to place, then release the mouse. 

¾ You should see the Option Group Wizard. Enter Main as the label for the first option, then 
press the Tab key to move to the next line. Type North and press Tab to move to the next line. 
Enter South as the third and last option. Click Next. 
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¾ The option button to select Main (the first label that was entered) as the default is selected. 
Click Next. Main, North, and South will be assigned the values 1, 2, and 3, respectively 
(Numeric entries are required for an option group). Click Next. 

 
¾ Click the drop-down arrow to select the field in which to store the value selected through the 

option group, scroll until you can select Campus. Click Next. Make sure the option button is 
selected as the type of control. 

 
 

¾ Click the Option button for the Sunken style to match the other controls on the form. Click 
Next. 

¾ Enter Campus as the caption for the group. Click the Finish command button to create the 
option group on the form. Click and drag the option group to position it on the form under the 
GPA control. 

¾ Point to the border of the option group on the form, click the right mouse button to display a 
short cut menu, and click Properties. Click the All tab. Change the name to Campus.Close the 
dialog box. Close the field list. Save the form. 
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STEP 5 : Add a Command Button 

¾ Click the Command button tool. The mouse pointer changes to a tiny crosshair attached to a 
command button when you point anywhere in the form. 

¾ Click and drag in the form where you want the button to go, then release the mouse. This 
draws a button and simultaneously opens the Command Button Wizard.  

¾ Click the Record Operations in the categories list box. Choose Add New Record as the 
operation. Click Next. 

¾ Click the Text option button in the next screen. Click Next. Type Add Record as the name of 
the button, then click the Finish command button. The completed command button should 
appear on your form. Save the form. 
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STEP 6 : Create the Additional Command Buttons 

¾ Click the Command button tool. Click and drag in the form where you want the second button 
to go.  

¾ Click Record Navigation in the categories list box. Choose Find Record as the operation. 
Click Next command button. Click the Text option button in the next screen. Click Next 
command button. 

¾ Type Find Record as the name of the button, then click the Finish command button. The 
completed command button should appear on your form. 

¾ Repeat these steps to add the command buttons to delete record (Record Operations) and 
close the form (Form Operations). Save the form. 

 

 
 

STEP 7 : Reset the Tab Order 

¾ Click anywhere in the Detail section. Pull down the View menu. Click Tab Order to display the 
Tab Order dialog box. Click the AutoOrder command button so that the Tab key will move 
to fields in left-to-right, top-to-bottom order as you enter data in the form. Click OK to close the 
Tab Order dialog box. Save the form. 

 
STEP 8 : The Page Setup Command 

¾ Point to any blank area in the Detail section of the form. Click the right mouse button to 
display a shortcut menu, then click Properties to display the Properties dialog box for the Detail 
section. Click the Format tab. Click the text box for Height. Enter 9 to change the height of the 
Detail section to 9 cm. Close the Properties dialog box. 
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¾ If necessary, click and drag the right border of the form so that all controls are fully visible. Do 
not exceed a width of  20 cm. for the entire form. 

¾ Pull down the File menu. Click Page Setup to display the Page Setup dialog box. If necessary, 
click the Margins tab. Change the left and right margins to 25 mm. Click OK to accept the 
settings and close the Page Setup dialog box. 

 

STEP 10 : The Completed Form 

¾ Click the View button to switch to the Form view and display the first record in the table.  

¾ Complete the record by adding appropriate data for the Major, FinancialAid, and Campus fields 
that were added to the form in this exercise. 

¾ Click the Add Record command button to create a new record. Click the text box for Social 
Security Number. Complete the data, The record selector changes to a pencil as soon as you 
begin to enter data to indicate the record has not been saved. 

¾ Press the Tab key or the enter key to move from field to field within the record. Click the arrow 
on the drop-down list box to display the list of majors, then click the desired major. 

¾ Complete all of the information on the form. Press enter to move to the next record. Click the 
Close Form command button on the form. Click Yes if you see a message asking to save 
changes to the form design. 
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REPORTS 
 
A report is a printed document that displays information from a database. Reports are created 
through the Report Wizard, then modified as necessary in the Design view.  
 
The columnar (vertical) report is the simplest type of report. It lists every field for every record in a 
single column (one record per page). The records in this report are displayed in the same sequence 
as the records in the table on which the report is based.  
 
The Tabular report displays fields in a row rather than in a column. Each record in the underlying 
table is printed on its own row. Only selected fields are displayed, so the tabular report is more 
concise than the columnar report.  
 
 

                      Columnar Report           Tabular Report 
 
 
A report is divided into sections. These are: 
 

o Report header & footer 

o Page header & footer 

o Group header & footer 

o Detail section 

 

The report header appears once, at the beginning of a report. It typically contains its title and the 
date the report was printed. The report footer appear once, at the end of the report and displays 
summary information for the report as a whole. 
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The page header appears at the top of every page in a report and can be used to display column 
headings, and other descriptive information. The page footer appears at the bottom of every page 
and may contain page numbers or other descriptive information.  

 

A group header appears at the beginning of a group of records to identify the group. A group 
footer appears after the last record in a group and contains summary information about the group. 
Group headers and footers are used only when the records in a report are sorted (grouped) 
according to a common value in a specific field.  

 

The detail section appears in the main body of a report and is printed once for every record in the 
underlying table or query. It displays one or more fields for each record in a columnar or tabular 
fashion, according to the design of the report. 

 

 

 

Report header 

 

 

Page header 

 
 
 
 
 
 
 

Detail lines 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Page footer 

 
 
 
The Report Wizard is the easiest way to create a report. It asks you questions about the report you 
want, then builds the report for you. You can modify the report as you want in the Design view. In 
the New Report dialog box, you can select the table or query on which the report will be based  
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Move to Selected Fields 

 
 
 
 
 
 
 
 

Select the Table/Query 

Double-click Available Field 

 
 
 
 
After you select the underlying table, you select one or more fields from that table. Report Wizard 
then asks you to select a layout and a style and then the report is created.  
 

 
 
 
 
 
 
 
 
 

Select page orientation 

Select Layout type 

Select report style 
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     Design View 
 
After the report is created, you can modify the report, just as you can modify a form. Each section is 
composed of controls. A bound control has a data source such as a field in the underlying table. 
An unbound control has no data source. A calculated control contains an expression. 
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Laboratory work:  CREATING A REPORT 

Objectives 

• To use the report wizard to create a new report;  
• To modify an existing report by adding, deleting, and/or modifying its controls. 

EXERCISE 7 
STEP 1: The Report Wizard 

¾ Start Access.  Open Our Students database. 

¾ Click the Reports button in the Database Window, then click the Create report by using 
wizard command button to create the report. 

¾ You should see the dialog box, which displays all of the fields in the Students table. Click 
the LastName field in the Available Fields list box, then click the > button to enter this field 
in the Selected Fields. 

¾ Enter the remaining fields (FirstName, PhoneNumber, and Major) one at a time, by 
selecting the field name, then clicking the > button. Click the Next Command button when 
you have entered the four fields. 

 
¾ The first screen asks whether you want to choose any grouping levels. Click Next without 

specifying a grouping level. 

¾ The next screen asks whether you want to sort the records. Click the drop-down arrow to 
display the available fields, then select the LastName. Click Next. 

¾ The tabular layout is selected, as is Portrait orientation. Be sure the box is checked to 
Adjust field width so all fields fit on a page. Click Next. 

¾ Choose Corporate as the style. Click Next. 

¾ Enter Student Master List as the title for your report. The option button to Preview the 
Report is already selected. Click the Finish command button to exit the Report Wizard and 
view the report. 

STEP 2: Preview the Report 

¾ Click the maximize button so the report takes the entire window. 

¾ Click the drop-down arrow on the Zoom Control boz so that you can view the report at 
75%. Click the scroll arrows on the vertical scroll bar to view the names of additional 
students. 

¾ Click the Close button to close the Print Preview window and change to the Report Design 
view. 
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STEP 3: Modify an Existing Control 

¾ Click and drag the border of control containing the Now function from the report footer to 
the report header. 

¾ Size the control as necessary, then check that the control is still selected and click the 
Align Right button on the Formatting toolbar. 

 
¾ Point to the control, then click the right mouse button to display a shortcut menu and click 

Properties to display the Properties sheet. 

¾ Click the Format tab in the Properties sheet , Click the Format property, then click the 
drop-down arrow to display the available formats. Click Short Date, then close the 
Properties sheet. 

¾ Pull down the File menu and Save to save the modified design. 

STEP 4: Add an Unbound Control 
¾ Click the Label tool on the Toolbox toolbar, then click and drag in the report footer where 

you want the label to go and release the mouse. You should see a flashing insertion point 
inside the label control (If you see the word Unbound instead of the insertion point, it means 
you selected the Text box tool rather than the Label tool; delete the Text box and begin 
again). 

¾ Type Prepared by followed by your name. Press enter to complete the entry and also 
select the control. Point to the control, click the right mouse button to display the shortcut 
menu, then click Properties to display the Properties dialog box. 

¾ Click the down arrow on the scrool bar, then scroll until you see the Font Size property. 
Click in the Font Size box, click the drop-down arrow, then scroll until you can change the 
font size to 9. Close the Property sheet. 

STEP 5: Change the Sort Order 
¾ Pull down the View menu. Click Sorting and Grouping to display the Sorting and 

Grouping dialog box. The students are currently sorted by last name. 

¾ Click the drop-down arrow in the Field Expression box. Click Major (The ascending 
sequence is selected automatically). 

¾ Click on the next line in the Field Expression box, click the drop-down arrow to display the 
available fields, then click LastName to sort the students alphabetically within major. 

¾ Close the Sorting and Grouping dialog box. Save the report. 

¾ Close the database. Exit Access if you do not wish to continue with the next exercise at 
this time. 
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QUERIES 

Queries select records from one or more tables in a database so they can be viewed, analyzed, and 
sorted on a common datasheet. The resulting collection of records, called a dynaset (short for 
dynamic subset), is saved as a database object and can therefore be easily used in the future. The 
query will be updated whenever the original tables are updated. Types of queries are select 
queries that extract data from tables based on specified values, find duplicate queries that display 
records with duplicate values for one or more of the specified fields, and find unmatched queries 
display records from one table that do not have corresponding values in a second table. 

Create a Query in Design View 
Follow these steps to create a new query in Design View: 

1. From the Queries page on the Database Window, click the New button. 

 

 

2. Select Design View and click OK.  
3. Select tables and existing queries from the Tables and Queries tabs and click the Add 

button to add each one to the new query.  
4. Click Close when all of the tables and queries have been selected. 
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5. Add fields from the tables to the new query by double-clicking the field name in the table 
boxes or selecting the field from the Field: and Table: drop-down menus on the query form. 
Specify sort orders if necessary. 

 

 

6. Enter the criteria for the query in the Criteria: field. The following table provides examples 
for some of the wildcard symbols and arithmetic operators that may be used. The 

Expression Builder can also be used to assist in writing the expressions. 

Query Wildcards and Expression Operators  
Wildcard / 
Operator Explanation 

? Street The question mark is a wildcard that takes the place of a single 
letter. 

43th * The asterisk is the wildcard that represents a number of characters. 

<100 Value less than 100 

>=1 Value greater than or equal to 1 

<>"FL" Not equal to (all states besides Florida) 

Between 1 and 10 Numbers between 1 and 10 

Is Null 
Is Not Null 

Finds records with no value 
or all records that have a value 

Like "a*" All words beginning with "a" 

>0 And <=10 All numbers greater than 0 and less than 10 

"Bob" Or "Jane" Values are Bob or Jane  
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7. After you have selected all of the fields and tables, click the Run button on the toolbar.  
8. Save the query by clicking the Save button.  

Query Wizard 
Access' Query Wizard will easily assist you to begin creating a select query.  

1. Click the Create query by using wizard icon in the database window to have Access step 
you through the process of creating a query.  

 

           
 

2. From the first window, select fields that will be included in the query by first selecting the 
table from the drop-down Tables/Queries menu. Select the fields by clicking the > button to 
move the field from the Available Fields list to Selected Fields. Click the double arrow 
button >> to move all of the fields to Selected Fields. Select another table or query to 
choose from more fields and repeat the process of moving them to the Selected Fields box. 
Click Next > when all of the fields have been selected. 

          
       

3. On the next window, enter the name for the query and click Finish.  
4. Refer to steps 5-8 of the previous tutorial to add more parameters to the query. 
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Laboratory work:  CREATING A QUERY – GROUPING RECORDS 

Objectives 

• To create a query containing a calculated control 
• Then, create report based on that query 
• To use the Sorting and Grouping command to add a group header and group footer to a 

report 

EXERCISE 8 
STEP 1 :  Create the Query 

¾ Start Access and open the Our Students database. 

¾ Click the Queries button in the Database window. Double click Create Query in Design view 
to display the Query Design Window. 

¾ The Show table dialog box appears; the Tables tab is already selected as is the Students 
table. Click the Add button to add the table to the query (the field list should appear).  

¾ Click Close to close the Show Table dialog box. 

 
¾ Click the Maximize button. Make the field list larger, to display more fields at one time. 

¾ Click and drag the Major field from the field list to the query. Click and drag the LastName, 
Gender, FinancialAid, QualityPoints, and Credits fields (in that order) in similar fashion. 

¾ Click the Sort row for the Major field. Click the down arrow to open the drop-down list box. 
Click Ascending. 

¾ Click the Sort row for the LastName field. Click the down arrow to open the drop-down list box. 
Click Ascending. 
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STEP 2 : Add a Calculated Control 

¾ Click in the first blank column in the field row. Enter the expression   =[QualityPoints]/[Credits] 
. 

¾ Press Enter. Access has substituted Expr1: for the equal sign you typed initially. Drag the 
column selector boundary so that the entire expression is visible. 

 
¾ Pull down the File menu and click Save to display the dialog box. Enter GPA By Major for the 

Query Name. Click OK. 

STEP 3 : Run the Query 

¾ Pull down the Query menu and click Run ( or click the Run button on the Query Design 
toolbar). You will see the dynaset. 

 
• Students are listed by major and alphabetically by last name within major. 
• The GPA is calculated to several places and appears in the Expr! Field. 
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STEP 4 : Modify the Query 

¾ Click the View button in order to modify the query. 

¾ Click and drag to select Expr1 in the Field row for the calculated field (Do not select the 
column). Type GPA to substitute a more meaningful field name. 

¾ Point to the column and click the right mouse button to display a shortcut menu. Click 
Properties to display the Field Properties dialog box. Click the General tab if necessary. 

• Click the Description text box. Enter GPA. 
• Click the Format text box. Click the drop-down arrow to display the available formats. 

Click Fixed. Set Decimal places to 2. 
• Close the Field Properties dialog box. 

¾ Click Save button to save the modified query. 

STEP 5 : Rerun the Query 

¾ Click the Run button to run the modified query. You will see a new dynaset corresponding to 
the modified query.  

• Students are listed by major and alphabetically within the major. 
• The Gpa is calculated to two decimal places and appears under GPA field. 

¾ Click the QualityPoints field for Chistopher Gibson. Replace 60 with 70. press enter. The GPA 
changes automatically to 2. 

¾ Pull down the Edit menu and click Undo Current Field/Record (or click the Undo button on 
the Query toolbar). The GPA returns to its previous value. 

¾ Tab to the GPA field for Chistopher Gibson. Type 2. Access will beep and prevent you from 
changing the GPA because it is a calculated field as indicated on the status bar. 

¾ Click the Close button to close the query and return to the Database window. Click Yes if 
asked whether to save the changes. 

STEP 6 : The Report Wizard 

¾ You should see the Database window. Click the Reports button, then double click Create 
Report by using Wizard to start the Report wizard. 

¾ Select GPA By Major from the Tables/Queries drop-down list. The available fields list displays 
all of the fields in the GPA By Major query. 

• Click the Major field in the Available fields list box. Click the  >  button. 
• Add the LastName, Gender, FinancialAid, and GPA fields one at a time. 
• Do not include the QualityPoints or Credits fields. Click Next. 
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¾ You should see the screen asking whether you want to group the fields. Click (select) the Major 
field, then click the  >  button. The Major field appears above the other fields to indicate that the 
records will be grouped according to the value of the Major field. Click Next. 

¾ The next screen asks you to specify the order for the detail records. Click the drop-down 
arrow on the list box for the first field. Click LastName to sort the records alphabetically by the 
last name within each major. Click Next. 

¾ The Stepped Option button is already selected for the report layout, as is Portrait 
Orientation. Be sure the box is checked to Adjust field width so all fields fit on a page. Click 
Next. 

¾ Choose Compact as the style. Click Next. 
¾ GPA By Major (which corresponds to the name of the underlying query) is already entered as 

the name of the report. Click the Option button to Modify the report’s design. Click Finish to 
exit the Report Wizard. 

STEP 7 : Sorting and Grouping 

¾ You should display the Report Design  view. Maximize the report window. 
¾ Move, size and align the column headings.  
¾ Pull down the View menu. Click Sorting and Grouping to display the Sorting and Grouping 

dialog box. 
¾ The Major field should already be selected. Click the Group Footer property, click the drop-

down arrow, then click Yes to create a group footer for the Major field. 

 
¾ Close the dialog box. The Major footer has been added to the report. Click the Save button to 

save the modified report. 

STEP 8 : Create the Group Footer 

¾ Click the Text Box button on the Toolbox toolbar. The mouse pointer changes to a tiny 
crosshair with a text box attached. 

¾ Click and drag in the group footer where you want the text box (which will contain the average 
GPA) to go. Release the mouse. 

¾ You will see an Unbound control and an attached label containing a field number( such as Text 
19). 

¾ Click in the text box of the control (Unbound will disappear). Enter  =Avg(GPA)  to calculate 
the average of the GPA for all students in this group. 

¾ Click in the attached Unbound control, click and drag to select the text (Text 19), then type 
Average GPA for Major  as the label for this control. Size, move and align the label.  

¾ Point to the Average GPA control, click the right mouse button to display a shortcut menu, 
then click Properties to display the Properties dialog box. If necessary, click the All tab, then 
scroll to the top of the list to view and/or modify the existing properties: 

• The Control Source text box contains the entry  =Avg([GPA])  from the preceding step. 
• Click the Name text box. Replace the original name ( Text 19 ) with Average GPA for 

Major. 
• Click the Format box. Click the drop-down arrow and select Fixed. 
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• Click the box for the Decimal places. Click the drop-down arrow and select (click) 2. 
¾ Close the Properties dialog box to accept these settings and return to the report. Click the Save 

button on the toolbar. 

 
STEP 9 : Create the Report Footer 

¾ The report footer is created in similar fashion to the group footer. Click and drag the bottom of 
the report footer to extend the size of the footer. 

¾ Click the Text Box button on the Toolbox toolbar, then click and drag in the report footer where 
you want the text box to go. Release the mouse. You will see an Unbound control and an 
attached label containing a field number (such as Text21). 

¾ Click in the text box of the control (Unbound will disappear). Enter  =Avg(GPA)  to calculate 
the average of the grade point averages for all students in the report. 

¾ Click in the attached label, click and drag to select the text (Text21) , then type  Average GPA 
for All Students  as the label for this control. Move, size and align the label appropriately. 

¾ Size the text box, then format the control: 
• Point to the control, click the right mouse button to display a shortcut menu, then click 

Properties to display the Properties dialog box. Change the properties to Fixed Format, 
with 2 decimal places. Change the name to  Average GPA for All Students. 

¾ Close the Properties dialog box to accept these settings and return to the report. Click the Save 
button on the toolbar. 

STEP 10 : View the Report 

¾ Click the Print Preview button to view the completed report. The status bar shows you are on 
page 1 of the report. 

¾ Click the Zoom button to see the entire page. Click the Zoom button a second time to return 
to the higher magnification, which lets you read the report. 

¾ Pull down the File menu and click Print to display the Print dialog box. The All option button 
is already selected under Print Range. Click OK to print the report. 

¾ Pull down the File menu and click Close to close the GPA By Major report. Click Yes if asked 
to save design changes to the report. 

¾ Close Our Students database. 
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Action Queries   

Select queries are used to determine which records and fields are displayed and their sort order, 
but they do not change the contents of the fields in the table. Access also lets you create Action 
queries, which change existing data or add new data to tables. You can use the following types of 
Action queries: 

• An Update query changes the data in the table in ways that you specify. 
• The Make Table query creates a new table that holds the data that is the result of     the query. 
• An Append query adds the data in records in the current table to another table  
• The Delete query deletes records that you specify. 

Warning: All of these Action queries work quickly and their results are not reversible. To avoid 
errors, you should always back up a table before performing an Action query on it. Action queries 
do not create a list like select queries. 

In addition, to avoid losing data, it is always best to run an Action query as a select query first. After 
you are sure that it isolates the records you want, convert it to an Action query and run it.  

An action query still is a query. So you start by creating a query, using the table or tables that 
contain the records that you want to manipulate. Then click the Query menu as shown below, the 
last four of which are action queries.  

 

 

 

 

 

 

 

 

 
 

An update query changes multiple records within a table. You can also use criteria in the update 
query. For example, suppose you want  to change the values in YEAR-TAKEN field of MAN256 
course that was taken by the students who live in Ankara  to 1997.     

• First, create a select query which satisfies the conditions as shown below. 
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• Then, From Query Menu select update query command, and write 1997 to cell of Update   
To row of YEAR-TAKEN field.  

 

 

 

 

 

 

• Run the query. You will see a warning dialog box as shown below. Read the message and 
Press Yes button. 

 

  

 

• It will update selected records  

A make-table query creates a new table from records in an existing table. This type of query is 
especially useful prior to running a delete query in that you can back up (archive) the records you 
are about to delete 
 
Make table queries have a couple of advantages. First, you can use a criteria. Thus you can better 
define the records to be ncluded in the new table. Second, a report based on a query includes up-
to-date values from the underlying table.  

When you choose Make Table from Query menu, Access displays the Make Table dialog box, 
shown below, which you use to specify the table, the data will be stored in. 
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The current database button is selected by default. If 
you want to store the data in a table in the current 
database, simply enter its name in the Table Name 
text box. If you enter the name of a new table, Access 
creates that  table and stores the result of the query in 
it. If you enter the name of an exsisting table or use 
the drop-down list to select it, Access replaces the 
data in that table with the result of the query. 

If you want to store the data in a table in another database, select the Another Database button, 
and enter the full path name of the ….MDB file  in the File Name dialog box. Then enter the table 
name. 

When you finish with the Make Table dialog box, use the Query window exactly as you do for select 
query to specify the records, fields, sort order of the new table. 

If you want to change the table the results are stored in, you can do so by choosing Make Table 
from the Query menu at any time while you are designing the query to display the Make Table 
dialog box again. 

For example, suppose you want to create a new table in REAL Super Market database with name 
CRTBL01. The query is shown below: 

    

 

 

 

 

 

 

 

 

 

• Select Query menu and click Make Table query and write table name CRTBL01 in Table 
Name box. Press OK button. 

• Run the query. 
• You will see a dialog box similar to the one given below. 
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Press Yes button. It will create 
CRTBL01 table. Now, click Tables 
tab. You should see a table with this 
name. The content of the table is 
shown below. 

 

You should reorganize the 
column widths.  

If you want, you can click 
design view and modify the 
design. 

 

An append query adds records from one table to the end of another table. An append query 
can include criteria, so that it adds only selected records. Append queries are similar to Make 
Table queries except that the data is appended to an existing table, without affecting the data 
already in that table.  

When you choose Append from Query menu, Access displays the Append dialog box, which 
is identical to Make Table dialog box. This box lets you specify the table that the data will be 
appended (added) to.  Notice that the Design grid does not have the show row that it does in 
select queries as shown below. . Instead, it has an Append To row, which you may use to 
select fields in the table you are appending the data to, in order to indicate which fields in the 
current table they correspond to. Click a cell in the Append To row to display a drop-down list 
that lets you choose among fields in the table you are appending to.  

For example, suppose you want to add records of customer with Customer Code 55 to 
CRTBL01 the Design view is as follows. 
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A delete query deletes one or more records from a table according to the designated criteria.  
It is easy to select individual records in a table and press Delete to delete them, and it is easy to 
choose Select All from the Edit menu and then press Delete to delete all the records in a table. If 
you have to delete  records that meet some criterion, though, it is obviously easier to use a Delete 
query than to select the records individually. 
 
For example, suppose you want to delete all records from Item sold in April from ITEMS-SOLD 
table.  
When you select Delete from Query menu, Access displays the query window as shown below. It 
does not include the Sort or Show rows. Instead it includes a Delete row. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A warning message is shown, when you run the query.  
Press yes button if you want to delete 5834 records. 
 
 

 

 

 
Compacting and Repairing a Database 

If you delete data or objects from a database, the database can become fragmented and use disk 
space inefficiently. Compacting rearranges how the database is stored on disk and optimizes the 
performance of the database. Access combines compacting and repairing into one process. 

• Open a database. 
• Choose Database Utilities on the Tools menu.  
• Click Compact and Repair Database. 
• When finished, close database. 
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Laboratory work:  CROSS TAB AND ACTION QUERIES  

Objectives 

• To use action queries to modify a database 
• To create a crosstab query to display summarized values from a table 

EXERCISE 9 
STEP 1:  Create the Make-Table Query 

¾ Open Our Students database. Click the Queries button in the Database Window, then 
double click Create query in Design view. 

¾ The Show Table dialog box appears automatically with the Tables tab already selected. If 
necessary, select the Students Table, then click the Add button to add the table to the 
query. Close the Show Table dialog box. Maximize the query window. 

¾ Click the SSN (the first field) in the Students table. Press and hold the Shift key, then scroll 
(if nesessary) until you can click Major in the table. Click and drag the selected fields form 
the field list to the design grid. 

¾ Scroll in the design grid until you can see the Credits field. Click in the Criteria row for the 
Credits field and enter >=120. 

¾ Click the drop-down arrow next to the Query Type button on the toolbar and select (click) 
the make-table query. Enter Graduating Seniors as the name of the table you will create. 

¾ Verify that the option button for Current Database is selected then click OK. 

STEP 2: Run the Make-Table Query 

¾ Click Run button to run the make-table query. Click Yes in response to the message 
indicating that you are about to paste one record (for the graduating seniors) into a new 
table. 

¾ Do not be concerned if you do not see the Graduating Seniors table at this time; i.e., unlike 
a select query, you remain in the Design view after executing the make-table query. Save 
the query as Archive Graduating Seniors. 

¾ Click the Tables button in the Database window, then open the Graduating Seniors table 
you just created. The table should contain one record (for Kim Zimmerman) with 120 or 
more credits. Close the table. 

STEP 3: Create the Delete Query 

¾ Click the Queries button in the Database window, then click the Archive Graduating 
Seniors query to select the query. Pull down the Edit menu. Click Copy to copy the query 
to the clipboard. 

¾ Pull down the Edit menu a second time, then click the Paste command to display the 
Paste As dialog box. Type Purge Graduating Seniors as the name of the query, then click 
OK. 

¾ The Database window contains the original query (Archive Graduating Seniors) as well as 
the copied version (Purge Graduating Seniors) you just created. 

STEP 4: Complete and Run the Delete Query 

¾ Open the newly created query in the Design view. Maximize the window. Click the drop-
down arrow next to the Query Type button on the toolbar and select (click) the Delete 
Query. 

¾ Click and drag the box on the horizontal scroll bar until you can see the Credits field. The 
criteria, >=120, is already entered because the Delete query was copied originally from 
Make Table query and the criteria are identical. 
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¾ Click the Run button to execute the query. Click Yes when warned that you are about the 
delete one record from the specified table. Once again, you remain in the design view after 
the query has benn executed. Close the query window. Click Yes if asked to save the 
changes. 

¾ Open the Students table. The record for Kim Zimmerman is no longer there. Close the 
sutdents table. 

 
STEP 5: Create the Append Query 

¾ Click the Queries button then double click Create query in design view. The Show Tables 
dialog box opens and contains the following tables: 

o The Students table that you have used throughout the lab sessions. 
o The Graduating Seniors table you just created. 
o The Transfer Students table that will be appended to the Students table. 

¾ Select the Transfer Students table then click the Add button add this table to the query. 
Close the Show Table dialog box. Maximize the window. Click and drag asterisk from the 
field list to the query design grid. 

¾ Click the drop-down arrow next to the Query type button on the toolbar and select (click) 
Append Query to display the Append dialog box. Click the drop-down arrow on the Append 
to Table name list box and select the Students table. 

¾ Click the Run button. Click Yes when warned that you are about to add 4 rows (from the 
Transfer Students table to the Students table). 

¾ Save the query as Append Transfer Students. Close the query window. 

¾ Open the Students table. Four records have been added (Liquer, Thomas, Rudolph, 
Milgrom). Close the table. 

 

STEP 6: Create an Update Query 

¾ Click the the Query button in the Database window. Select (click) the GPA by Major 
Query, press Ctrl+C to copy the Query, then press Ctrl+V to display the paste as the dialog 
box. Enter Update Financial Aid. Click OK. 

¾ Open the newly created query in the design view. Click the drop-down arrow next to the 
Query Type button on the toolbar and select (click) Update Query. The Query grid changes 
to include an Update To:  row and the Sort row disappears. 

¾ Click in the Criteria row for the GPA field and enter >=3. Click in the Update to Row for the 
FinancialAid field and enter Yes. The combination of these entries will change the value of 
the Financial Aid field to “yes” for all students with a GPA of 3.00 or higher.  

¾ Click the Run button to execute the query. Click Yes when warned that you are about to 
update nine records. Close the query window. Click Yes if asked whether to save the 
changes. 

STEP 7:  Check Your Progress 

¾ Click the Tables button in the Database window. Open (double click) the Students, 
Graduating Seniors, and Transfer Students tables one after another. You have to return to 
the Database window each time you open a table. 

¾ Pull down the Window menu and click the Tile Vertically coommand to display the tables. 
The arregment of your tables may be different from ours. 

¾ Check your progress by comparing the tables to one other: 

o Check the first record in the Transfer Students table, Lindsey Liquer, and note that 
it has been added to the Stıdents table via the Append Transfer Students query . 

 58  



 

o Check the record in the Graduating Senior table, Kim Zimmerman, and note that it 
has been removed from the Students table via the Purge Graduating Seniors 
query. 

o The Students table reflects the table reflects the current student database. The 
other two tables function as back up. 

¾ Close the Students, Transfer Students, and Graduating Seniors tables. 

STEP 8: Create a Crosstab Query 

¾ Click the Queries button in the Database window, click New, click the Crosstab Query 
Wizard in the New Query dialog box and click OK to start the wizard. 

¾ Click the Queries option button and select the GPA by Major query. Click Next. 

o Click Major in the avaiablel field list, then click > to place it in the selected fields 
list. Click Next. 

o Click Gender as the field for column headings. Click Next.  
o Click GPA as the field to calculate and select the Avg.function. Clear the check 

box to include to row sums. Click Next. 
o The name of the query is suggested for you, as is the option button to view the 

query. Click Finish. 

¾ The results of the crosstab query are shown. The query lists the average GPA for each 
combination of major and gender. The display is awkward, however, in that  the GPA is 
calculated to an unnecessary number of decimal places. 

¾ Click the View Button to display the Design view for this query. Right click in the GPA 
column to display a context-sensitive menu, click Properties to display the Field Properties 
dialog box, click in the Format row, and select Fixed. Set the number of decimals to two.  

¾ Click the Run button to re-execute the query, This time the GPA is displayed to two 
decimal places. Save the query. Close the Query window. 

¾ Close the Our Students database. Exit Access. 
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 RELATIONAL DATABASES, SUBFORMS, EXTERNAL DATA AND  
THE SWITCHBOARD 

 
 
A relational database contains multiple tables. Each table stores data about a specific entity in the 
physical system, such as customers and loans in an investment system. The tables are related to 
one another through a one-to-many relationship; for example, one customer may have many loans.   
 
The relationship is created in the Relationship window by dragging the join field from the one table 
to the related table. This one-to-many relationship is implemented in the database by including a 
common field, CustomerID, in both tables. The CustomerID is the primary key in the Customers 
table. It also appears as a foreign key (the primary key of another table) in the Loans table in order 
to relate the two tables to one another 
 
The data from both tables can be combined through this relationship to provide complete 
information about any customer and his/her loan, or about any loan and its customer. 
 

 

CustomerID is 
primary key in 
Customers table 

Relationships 
line 

CustomerID is foreign key 
in Loans table 

Enforce 
Referential 
Integrity 

Relationship Window 

The design of the database, with separate tables for customers and loans, makes it easy to add, 
edit, or delete information about a customer or loan. To add a new customer or loan, you should 
just go to the respected table and add the record. Similarly, to change the data for an existing 
customer or loan, you go to the appropriate table, locate the record, and make the change.  

The advantage of the relational database is that, when you change the customer information in one 
place; for example, change the phone number of a customer and the change will be automatically 
reflected for every loan associated with this customer. 

The tables in the database must be consistent with one another, a concept is known as referential 
integrity. For example, you can always delete a record from the Loans table (the “many” table in 
this example). But you cannot delete a record from the Customers table (the “one” table) when 
there are loans assigned to that customer, because these loans would then be assigned to a 
customer who did not exist. Access controls the relationships that are in effect and prevents you 
from making changes that do not make sense. It will enforce referential integrity automatically. 
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                                 Referential Integrity 

Delete Record button 

Click + sign to display 
related records 

Cannot delete Customer without 
first deleting related Loan 

     

 61  



 

Laboratory work:  CREATING A RELATIONAL DATABASE  

Objectives 

• To open a database with multiple tables;  

• To identify the one-to-many relationships within the database and to produce reports based 
on those relationships. 

EXERCISE 10 
STEP 1: Open the Relationships Window 

¾ Start Access. Open the Look Ahead database. 

¾ The Tables button should be selected. The database contains Employees, Locations, and 
Titles tables. 

¾ Pull down the Tools menu and click the Relationships command to open the 
Relationships window. (The tables are not yet visible in this window.) 

¾ Pull down the Relationships menu and click the Show Table command to display the 
Show Table dialog box. Click the Locations table then click the Add button to add this 
table to the Relationships window. 

¾ Double click the Titles and Employees tables to add these tables to the Relationships 
window. 

¾ Close the Show Table dialog box. 

STEP 2: Create the Relationships 

¾ Maximize the Relationships windows so that you have more room in which to work. Click 
and drag the title bar of each table so that the positions of the tables match. Click and drag 
the bottom (and/or right) border of each table so that you see all of the fields in each table. 

¾ Click and drag the LocationID field in the Locations table field list to the LocationID field 
in the Employees field list. You will see the Edit Relationships dialog box. Chech the box to 
Enforce Referential Integrity. Click the Create button to create the relationship. 

¾ Click and drag the TitleID field in the Titles table field list to the TitleID field in the 
Employees field list. You will see the Edit Relationships dialog box. Chech the box to 
Enforce Referential Integrity. Click the Create button to create the relationship. 

¾ Click the Save button on the Relationship toolbar to save the Relationships window, then 
close the Relationships window. 

STEP 3: Enter Your Own Record 

¾ Double click the Employees table to open the table. Maximize the window. Pull down the 
Insert menu and click the New Record command on the Table Datasheet toolbar. 

¾ Enter data for yourself, using your own social security number, and your first and last name. 
Enter an invalid LocationID (e.g., L44) then complete the record. 

¾ Press the enter key when you have completed the data entry, then click OK when you see 
the error message. Access prevents you from entering a location that does not exist. 

¾ Click in the LocationID field and enter L04, LocationID for Miami. Press the down arrow 
key to move to the next record, which automatically saves the current record. Close the 
Employees table. 

STEP 4: Simplified Data Entry 

¾ Click the Forms button in the Database window, then double click the Employees form to 
open this form. Click the Add Record button then click the text box for the Social Security 
Number. 
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¾ Enter the data for Bob Grauer one field at a time, pressing the Tab key to move from one 
field to the next. Click the down arrow when you come to the location field to display the 
available locations, then select Miami. 

¾ Press the Tab key to move to the Title field and choose Account Rep. Complete the data 
for Bob’s record by entering $150,000, M, and Excellent in the Salary, Gender, and 
Performance fields, respectively. 

¾ Click the Close Form button when you have finished entering the data. 

 
STEP 5: View the Employee Master List 

¾ Click the Reports button in the Database window. Double click the Employee Master List 
report to open the report. 

¾ This report lists selected fields for all employees in the database. Note that the two new 
employees, you and Bob Grauer, in alphabetical order. Both employees are in the Miami 
Office. 

¾ Close the Report window. 

 

STEP 6 : Change the Locations Table 

¾ Click the Tables button in the Database window, then double click the Locations table to 
open this table. Maximize the window. 

¾ Click the plus sign next to location L04 (Miami) to view the employees in this office. The 
plus sign changes to a minus sign as the employee records for this location are shown. 
Your name appears in this list as does Bob Grauer’s. Click the minus sign and the list of 
related records disappears. 

¾ Click and drag to select Miami (the current value in the Location field). Type Orlando and 
press the Tab key. Enter the corresponding values for the other field: 1000 Kirkman Road, 
FL, 32801 and (407) 555-55555 for the address, state, zip code, and office phone, 
respectively. 

¾ Close the Locations table. You have moved the Miami Office to Orlando. 

 

STEP 7 : View the Employees by title Report 

¾ Click the Reports button in the Database window, then double click the Employees by 
Title report to open the report. 

¾ This report lists employees by title, rather than alphabetically. Note that you and Bob 
Grauer are both listed as Account Reps in the Orlando office; i.e., the location of the office 
was changed in the Locations table and that change is automatically reflected for all 
employees assigned to that office. 

¾ Close the report window. Close the Database window. Exit Access. Welcome to the world 
of relational databases☺  
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Subforms 

Subform is a form within a form. A main form can have multiple subforms. Main table can have 
multiple levels of subforms. Subform is useful for displaying a one-to-many relationship within a 
one-to-many relationship.  

  

 

Customer C01 

Loans for Customer C01 

Status bar for Customers form 
Status bar for Loans form 

 
 
 
The easiest way to create a subform is by using the Subform Wizard. 
 
1. First select the table and the fields from that table.  

 

Select the Customers table 

Select >> to add all 
fields to the form 
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2. Select the second table and the fields from this table. 

 
 

Select the Loans table 
for the submenu 

Select >> to add all 
fields to the form 

3. Choose how you want to view the records. 

 

Choose to view the 
records by customer 

 
4. Choose a layout. 

 
 
 
 
 

 65  



 

 
5. Choose a style. 

 
 

6. Save your form and subform as separate objects. 
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Laboratory work:  ADDING A SUBFORM TO A FORM 

Objectives 

• To define the relationship between two tables;  
• To add a subform to a form 

 

EXERCISE 11 

 
STEP 1: Open the GardenCorparation database. 

STEP 1:  On the Access toolbar, click the Relationships button  to open the Relationships 
window. 

STEP 3: If the Show Table dialog box isn’t displayed, click the Show Table button  on the 
toolbar, and then double-click Categories and Products in the list displayed.  
 
STEP 4:  Close the Show Table dialog box to view the Relationships window, which looks like this: 
 

 
 
STEP 5: Point to the CategoryID in one table, and drag it on top of CategoryID in the other table.  

Access displays the Edit Relationships dialog box, which lists the fields you have chosen to relate 
and offers several options, as shown here: 
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STEP 6:  Click the Enforce Referential Integrity check box, click the other two check boxes, and 
then click Create. 

Access draws a line representing the one-to-many relationship between the CategoryID fields in 
each of the tables. 

Tip: When the Cascade Update Related Fields check box is selected, changing a primary key 
value in the primary table automatically updates the matching value in all related records. When the 
Cascade Delete Related Records check box is selected, deleting a record in the primary table 
deletes any related records in the related table. You can edit or delete a relationship by right-
clicking the line and clicking the appropriate command on the shortcut menu. 
 
STEP 7: Close the Relationships window, clicking Yes when prompted to save its layout. 

STEP 8: Open the Categories form in Design view. 

STEP 9: Maximize the Form window, and drag the Form Footer section selector down about 2.5 
cm to give yourself some room to work. 

STEP 10: If the toolbox isn’t displayed, click the Toolbox button . 

STEP 11: Make sure the Control Wizards button  in the toolbox is active (has a border around 
it). 

STEP 12: Click the Subform/Subreport button , and drag a rectangle in the lower portion of the 
Details section. 

A white object appears on the form, and the first page of the Subform Wizard opens. 

STEP 13:  Leave Use existing Tables and Queries selected, and click Next. 

STEP 14: In the Tables/Queries list, click Table:Products. 

STEP 15: Add the ProductName, CategoryID, QuantityPerUnit, UnitPrice, and UnitsInStock 
fields to the Selected Fields list by clicking each one and then clicking > button.  
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Step 16: Then click Next to display this third page of the wizard. Because a field in the subform is 
related to a field in the main form (CategoryID), the wizard selects Show Products for each record in 
Categories using CategoryID as the Choose from a list option. 

Tip: If the wizard can’t figure out which fileds are related, it selects the Define my own option and 
displays list boxes in which you can specify the fields to be related. 

STEP 17: Click Next to accept the default selection, and then click Finish to accept the default 
name for the subform and complete the process. 

Access displays the Categories form in Design view, with an embedded Products subform. The size 
and location of the subform is determined by the original rectangle you dragged on the form. 

STEP 18: Adjust the size and location of the objects on your form so that it resembles the one as 
follows. 

 
 

 

STEP 19: Notice the layout of the subform, and then click View to switch to Form view, where the 
form looks like this: 
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The format of the subform has totally changed. In Design view, it looks like a simple form, but in 
Form view, it looks like a datasheet. 

STEP 20: Switch back to Design view, make any necessary size adjustments, and if necessary, 
open the Properties dialog box. 

 
STEP 21:  Click the Form selector in the upper left corner of the subform twice. 

 
The first click selects the Products subform control, and the second click selects the form. A small 
black square appears in the button. 

STEP 22:  On the Format tab of the Properties dialog box, change both Record Selectors and 
Navigation Buttons to No. 

While on this tab, notice the Default View property, which is set to Datasheet. You might want to 
return to this property and try the other options after finishing this exercise. 
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STEP 23: Switch back to Form view, and drag the dividers between column headers until you can 
see all the fields (You can quickly adjust the width of columns to fit their data by double-clicking the 
double arrow between column headings). Here are the results: 

 
STEP 24: Click the navigation buttons to scroll through several categories. When you are through, 
click the First Record  button to return to the first category (Bulbs).  

As each category is displayed at the top of the form, the products in that category are listed in the 
datasheet in the subform. 

STEP 25: Click the category name to the right of the first product.  

The arrow at the right end of the box indicates that this is a combo box. 

STEP 26: Click the arrow to display the list of categories, and change the category to Cacti. 

STEP 27: Click the Next Record navigation button to move to the next category (Cacti). 

You can see that the first product is now included in this category. 

STEP 28: Display the list of categories, and restore the first product to the Bulbs category. 
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STEP 29: You don’t want people to be able to change a product’s category, so return to design 
view. Then in the subform, click the CategoryID combo box control, and press Delete key. 

Important: You included the CategoryID field when the wizard created this subform because it is 
the field that relates the Categories and Products tables. The underlying Products table uses a 
combo box to display the name of the category instead of its ID number, so that combo box also 
appears on the subform. 

STEP 30: Save the form, then switch back to Form view, and adjust the width of the subform 
columns and the size of the Form window until your form looks like this: 

 
STEP 31: Close the Categories form, saving your changes to both the form and the subform. Close 
the database. 
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Multiple table queries 

A select query can contain fields from multiple tables. The one-to-many relationship between those 
tables is shown graphically in the query design view. The tables are related through The Tables 
row displays the name of the table that contains each field in the query.  

 

Relationship 
between tables 

Each field & 
table to display 

 

External data 

Access provides an easy way to use external data. The Get External Data command starts a 
Wizard that will import (or link) data from an external source such as an Excel workbook into an 
Access database. The data may come from an Excel workbook, or from a text file that was created 
by an application outside of Microsoft Office. The Export command does the reverse and copies an 
Access database object to an external destination.  

The Import Spreadsheet Wizard asks you a series of questions, then it imports the Excel 
worksheet into the Access table. You select the worksheet, designate the Excel column headings 
and Access field names, and specify the primary key. You can then view and/or modify the resulting 
table.  
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                       The Excel Workbook                                           Designate Column Headings 

 

 Choose Primary Key      The Clients Table 
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Laboratory Work: IMPORTING AND EXPORTING ACCESS OBJECTS 

Objectives 

• To import an Access table from an Excel workbook. 
• To create a one-to-many relationship between tables in a database. 
• To create a multiple-table query. 

EXERCISE 12 
STEP 1: Import the Excel worksheet 

¾ Start Access. Click the link to More Files in the task pane or pull down the File menu and 
click the Open command. 

¾ Open the Investment database in the Exploring Access folder. 

¾ The database does not contain any tables yet. The tables will be imported from Excel. 

¾ Pull down the File menu, click the Get External Data command, then click Import to 
display the Import dialog box.  

¾ Click the down arrow on the Look in list box and change to Exploring Access folder. 

¾ Click the down arrow on the Files of type list box and select Microsoft Excel. Select the 
Investment Data workbook. Click the Import button to start the Import Spreadsheet 
Wizard. 

 
 

STEP 2: The Import Spreadsheet Wizard 

¾ In the first step of the Import Spreadsheet Wizard, the option button to Show Worksheet is 
selected. The Clients worksheet is also selected. Click Next. 

¾ Access will use the column headings in the Excel workbook as field names in the access 
table, provided you check the box indicating that the first row contains column headings. 
Click Next. 

¾ Select the option button to store the data in a new table. Click Next. 

¾ You do not need information about the individual fields. Click Next. 
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¾ Select the option to choose your own primary key. Click the drop-down arrow on the list 
box, and select SSN. Click Next. 

¾ Access indicates that it will import the data to a Clients table. Click The Finish button, then 
click OK. The Clients table appears within the Database window.  

¾ Repeat the steps to import the Consultants table into the Investment database from the 
Investment Data workbook. Use the ConsultantID field as the primary key for this table. 

 
 

STEP 3: Create the Relationship 

¾ Pull down the Tools menu and click the Relationship command. 

¾ Pull down the Relationship menu and click the Show Table command. Click (select) the 
Clients table, then click the Add button. 

¾ Double click the Consultants table to add this table to the Relationship window. Close the 
Show Table dialog box. Click and drag the title bar of each table. 

¾ Click and drag the bottom border of each table so that you see all of the fields in each table. 

¾ Click and drag the ConsultantID field in the Consultants table field list to the ConsultantID 
field in the Clients field list. You will see the Edit Relationships dialog box. 

¾ Check the box to Enforce Referential Integrity. Click the Create button to create the 
relationship. 

¾ Click the Save button. 

STEP 4: Create the Multiple Table Query 

¾ Click the Queries button in the Database window. Double click the icon to Create query in 
design view to open the Design window. The Show Table dialog box appears 
automatically. 

¾ Press and hold down the Ctrl key to select the Clients and Consultants tables, then click 
the Add button to add these tables to query. Close the Show Table dialog box.  

¾ Click the Maximize button. Click and drag the title bars of each table to arrange the tables, 
click and drag the bottom of each field list until you can see all of the fields in the table. 
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STEP 5: Complete the Multiple-Table Query 

¾ The Table row should be visible within the design grid. If not, pull down the View menu and 
click Table Names to display the Table row. 

¾ Double click the LastName and Status fields from the Consultants table to add these fields 
to the design grid. Double click the LastName, Assets, and Account Type fields from the 
Clients table to add these fields as well. 

¾ Click the Sort row under the LastName field from the Consultants table, then click the down 
arrow to open the drop-down list box. Click Ascending. 

¾ Click the Save button on the Query Design toolbar. Save the query as Assets Under 
Management. Click OK. 

¾ Click the Run button to run the query. 

 

STEP 6: Export the Query 

¾ You should see the dynaset created by the query as shown below. The query lists all of the 
client records grouped by the last name of the financial consultant.  

¾ Pull down the File menu, click (or point to) Export command to display the Export Query 
dialog box. Click the down arrow in the Save as type list box to select Microsoft Excel 97-
2003. 
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¾ Select the Investment Data workbook and click the Export All button to save the query 
as a worksheet in the Investment Data workbook. Click Yes if asked whether to replace the 
file. Close the Query window. 

¾ Click the Tables button. Select the Clients table. Pull down the File menu, Click the 
Export command, and change the file type to Microsoft Excel 97-2003. Select (click) the 
Investment Data workbook. Click Export. Click Yes if asked whether to replace the file. 

¾ Export the Consultants table in similar fashion. Exit Access. 

 

STEP 7: View the Excel Workbook 

¾ Click the Start button, click (or point to) the Programs command, then select Microsoft 
Excel. Click the Open button, change to the Exploring Access folder, then open the 
Investment Data workbook. 

¾ Click the Assets_Under_Management tab to see the worksheet. Format the worksheet to 
improve its appearance. 

¾ There are two client worksheets, Clients and Clients1, corresponding to the original and 
modified client data. Click the Clients1 tab. 

¾ There are also two consultant worksheets, Consultants and Consultants1. Click the 
Consultants1 tab. 

¾ Press and hold down the Ctrl key as you click the tab for each worksheet to select all five 
worksheets. Pull down the File menu, click the Page Setup command. Click the Sheet 
tab. Check the boxes to print Gridlines and Row and Column headings. Click OK. 

¾ Click the Print button to print the workbook. Save the workbook. Exit Excel. 
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The Switchboard Manager 

A switchboard is a user interface that enables a nontechnical person to open the objects in an 
Access database by selecting commands from a menu. The switchboard itself is stored as a form 
within the database, but it is quite different from the forms you have learned in the previous 
sections, it is not used for data entry, but rather as a menu for the user. 

 

Click button to open 
About Investments form 

The switchboard is created through the Switchboard Manager, a tool that prompts you for the 
information about each menu item. You supply the text of the item, as it is to appear on the 
switchboard, together with the underlying command. Access does the rest. It creates the 
switchboard form and an associated Switchboard Items table that is the basis for the switchboard.  

 

About Investments form 

Position of menu items 

       Design View 

The Form view and Design view do not appear to correspond to one another; text appears next to 
each button in the Form view, but it is absent in the Design view. This is the nature of a 
switchboard, because the text for each button is taken from the Switchboard Items table which is 
the record source for the form. Each record in the Switchboard Items table has a corresponding 
menu item in the switchboard form. 
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Number reflects 
position in menu 

            The Switchboard Items Table 

Switchboard Items table is created automatically. The SwitchboardID field identifies the number of 
the switchboard, which becomes important in applications with more than one switchboard.  

The ItemNumber and ItemText fields identify the position and text of the item, respectively, as it 
appears on the switchboard form. (The & that appears within the ItemText field will appear as an 
underlined letter on the switchboard to enable a keyboard shortcut; for example, Consultants is 
displayed as Consultants). The Command and Argument fields determine the action that will be 
taken when the corresponding button is clicked. Command number 3, for example, opens a form. 

Compact and Repair Database 

The Compact and Repair Database command in the Tools menu serves two functions. The 
compacting process eliminates the fragmentation and wasted disk space that occurs during 
development as you add, edit, and delete the various objects in a database. The Repair function 
takes place automatically if Access is unable to read a database when the database is opened 
initially. 
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 Laboratory Work: THE SWITHCHBOARD MANAGER 

Objectives 

• To create a switchboard;  
• To use the Link Tables command to associate tables in one database with the objects in a 

different database.  
 

EXERCISE 13 
STEP 1:    The Sports Objects Database 

¾ Start Access. Change to the Exploring Access folder as you have been doing throughout 
the text. 

¾ Open the Sports Objects database, and then click the various buttons in the Database 
window to view the contents of this database. This database contains the various objects 
(forms, queries, and reports) in the soccer application, but not the tables. 

• Click the Tables button. There are currently no tables in the database. 

• Click the Queries button. There is one query in the database. 

• Click the Forms button. There are six forms in the database. 

• Click the Reports button. There is one report in the database. 

¾ Pull down the File menu, click Database Properties, then click the Contents tab to see 
the contents of the database. The Database Properties command enables you to see all of 
the objects on one screen. 

¾ Click OK to close the dialog box. 

 
STEP 2:    The Link Tables Command 

¾ Pull down the File menu. Click Get External Data, then click Link Tables from the 
cascaded menu. You should see the Link dialog box (which is similar in appearance to the 
Open dialog box). 

¾ Select the Exploring Access folder, the folder you have been using throughout the text. 
Scroll (if necessary) until you can select the Sports Tables database, and then click the 
Link command button. 

¾ You should see the Link Tables dialog box in Figure. Click the Select All command button 
to select all three tables, then click OK. 
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¾ The system (briefly) displays a message indicating that it is linking the tables, after which 
the tables should appear in the Database window. 

¾ Click the Tables button in the Database window. The arrow next to each table indicates 
that the table physically resides in another database. (You may have to relink the tables if 
you move the database to another computer.) 

 
STEP 3:    Import the About Sports Form 

¾ Pull down the File menu, click the Get External Data command, and then click Import to 
display the Import dialog box. Select the Exploring Access folder, the folder you have 
been using throughout the text. 

¾ Scroll (if necessary) until you can select the About Sports database, then click the Import 
button to display the Import Objects dialog box in Figure. Click the Forms button, select 
the About Sports form, and click OK. The system pauses as the About Sports form is 
brought into this database. 

¾ Once the importing is complete, the Database window changes to display the forms in this 
database, which now includes the About Sports form. Open the form in the Design view, 
then modify its contents to include your name and school. Save your changes, then close 
the form. 

 
STEP 4:    Start the Switchboard Manager 

¾ Minimize the Database window. Pull down the Tools menu, click the Database Utilities 
command, and choose Switchboard Manager. 

¾ Click Yes if you see a message indicating that there is no valid switchboard. You should 
see the Switchboard Manager dialog box in Figure. 

¾ Click the Edit command button to display the Edit Switchboard Page dialog box. Click the 
New command button to add an item to this page, which in turn displays the Edit 
Switchboard Item dialog box. 

¾ Click in the Text list box and type &About Sports, which is the name of the command as it 
will appear in the switchboard. 

¾ Click the drop-down arrow on the Command list box. Choose the command to open the 
form in either Add or Edit mode (it doesn't matter for this form). 

¾ Click the drop-down arrow in the Form list box and choose About Sports. 

¾ Click OK to create the switchboard item. The Edit Switchboard Item dialog box closes and 
the About Sports item appears in the Main Switchboard. 
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STEP 5:    Complete the Switchboard 

¾ Click the New command button in the Edit Switchboard Page dialog box to add a second 
item to the switchboard. Once again, you see the Edit Switchboard dialog box. 

¾ Click in the Text list box and type &Players. Click the drop-down arrow on the Command 
list box and choose Open Form in Edit Mode. Click the drop-down arrow in the Form list 
box and choose Players. 

¾ Click OK to close the Edit Switchboard Item dialog box. The &Players command appears as 
an item on the switchboard. 

¾ Create two additional switchboard items for &Coaches and &Teams in similar fashion. 
Your switchboard should contain four items as shown in Figure. Click Close to close the 
Edit Switchboard Page dialog box. Click Close to close the Switchboard Manager dialog 
box. 

 
STEP 6:    Test the Switchboard 

¾ Click the Restore button in the Database window to view the objects in the database, then 
click the Forms tab. The Switchboard form has been created automatically by the 
Switchboard Manager. 
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¾ Double click the Switchboard form to open the Main Switchboard. Do not be concerned 
about the design of the switchboard at this time, as your immediate objective is to make 
sure that the buttons work. (We modify the design of the switchboard at the end of the 
exercise.) Maximize the window. 

¾ Click the About Sports button (or use the Alt+A shortcut) to display the About Sports form 
as shown in Figure. Click the OK button to close the form. 

¾ Click the Players button (or use the Alt+P shortcut) to open the Players form. 

Click the Maximize button so that the Players form takes the entire window. 

 
STEP 7:     Add Your Record 

¾ Click the Add Player button on the bottom of the form (or use the Alt+A shortcut) to 
display a blank record where you will enter data for yourself as shown in Figure. 

¾ Click the text box to enter your first name. (The PlayerlD is an AutoNumber field that is 
updated automatically.) Enter your name, then press the Tab key to move to the next field. 

¾ Continue to enter the appropriate data for yourself, but please assign yourself to the 
Comets team. The team is entered via a drop-down list. Type C (the first letter in Comets) 
and Comets is entered automatically from the drop-down list for teams. 

¾ The player rating is a required field (all players are evaluated for ability in order to balance 
the teams) and must be A, B, C, or D. 

¾ Click the Close Form button to return to the switchboard. 
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STEP 8:    Complete the Data Entry 

¾ You should once again see the switchboard. Click the Coaches button (or use the Alt+C 
shortcut) to open the Coaches form. 

¾ Click the Add Coach button at the bottom of the form. Click the text box to enter the 
coach's first name. (The CoachID is entered automatically.) 

¾ Enter data for your instructor as the coach. Click the appropriate option button to make 
your instructor a Head Coach. Assign your instructor to the Comets. Click the Close Form 
button to return to switchboard. 

¾ Click the Teams command button on the switchboard to open the Teams form and move 
to Team T02 (the Comets). You should see your instructor as the head coach and yourself 
as a player as shown in Figure. 

 

 85  



 

¾ Pull down the Edit menu and click Select Record (or click the selection area), then click 
the Print button to print the roster for your team. 

¾ Click the Close Form button to return to the switchboard. 

 

STEP 9:    Insert the Clip Art 

¾ Change to the Design view. Right click in the Picture area of the form to display a context-
sensitive menu, and then click the Properties command to display the Property sheet. 
Click the All tab. 

¾ The Picture property is currently set to "none" because the default switchboard does not 
contain a picture. Click in the Picture box, and then click the Build button to display the 
Insert Picture dialog box. 

¾ Click the down arrow in the Look In box to change to the Exploring Access folder, then 
select the SoccerBall. Click OK. 

¾ Size the picture as appropriate. The dimensions of the soccer ball should be changed to a 
square—for example, 1.7 inches X 1.7 inches. Close the property sheet. 

¾ Right click below the picture in the Detail area of the form. Point to the Fill/Back Color 
command from the context-sensitive menu to display a color palette. Choose the same 
shade as appears on the rest of the form. (It is the fifth square from the left in the second 
row.) 

¾ Click the Undo button if the color does not match. Save the form. 

 
STEP 10:    Complete the Design 

¾ Delete the label that contains the title of the switchboard, "Sports Objects". (You will have to 
delete two labels, because the switchboard manager automatically creates a shadow.) 

¾ Click and drag the Label tool to create a new unbound control for the title of the 
switchboard. Enter Any Sports League as the title. Use 18-point Arial bold, in white for the 
formatting. 

¾ Click the Label tool, then click and drag to create a text box under the picture. Enter your 
name in an appropriate font, point size, and color. Move and/or size the label containing 
your name as appropriate. 

¾ Press and hold the Shift key as you click each text box in succession. The boxes appear to 
be empty, but the text will be drawn from the Switchboard Items table. 

¾ Be sure that you selected all text boxes. Click the drop-down arrow on the Font/Fore Color 
button and change the color to white. Change the font and point size to Arial and 10pt, 
respectively. Save the form. 

¾ Change to the Form view to see the result of your changes. Exit Access if you do not want 
to continue with the next exercise at this time. 
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Introduction to Macros 

A macro automates a command sequence. Instead of using the mouse and keyboard to execute a 
series of commands, you store the commands (actions) in a macro and execute the macro. You can 
create a macro to open a table, query, form, or report. You can create a macro to display an 
informational message. You can create a macro to move or size a window, or to minimize, 
maximize, or restore a window. In short, you can create a macro to execute any command (or 
combination of commands) in any Access menu to make an application easier to use. 

A macro is created in the Macro window. The macro window is divided into two sections. The 
actions (commands) that comprise the macro are entered at the top. The arguments, or 
information for those actions, are entered in the lower section. Macros are stored as separate 
objects in a database.  

            

Name of macro 

Macro action 

Message box 
displayed by macro 

Message box text  

Message box title  

      The Macro Window 

To create a macro, select the Macros button in the database window, then click the New button to 
display the macro window. You add actions to a macro by clicking in the Action area then choosing 
the action from a drop-down list, or by typing the name of the action. The arguments of an action 
are entered by choosing from a drop-down list, or by typing the argument directly.  

After the macro is created, you can execute it whenever the application is open. Execution of the 
macro will display a dialog box. The contents of the dialog box are determined by the value of the 
arguments. The value of the Type argument determines the icon that is displayed within the dialog 
box. The Title argument contains the text that appears in the title bar of the dialog box.  

AutoExec Macro 

The AutoExec macro is unique that is executed automatically whenever the database in which it is 
stored is opened. The macro is used to automate a system for the end user. It typically contains an 
OpenForm action to open the form containing the main switchboard. It may also perform other basic 
tasks, such as maximizing the current window.  

 

 87  



 

Laboratory Work: MACROS AND PROTOTYPING  

Objectives 
• To create an AutoExec and a Close Database macro;  

 

EXERCISE 14 
STEP 1:    Create the AutoExec Macro 

¾ Start Access. Open the Sports Objects database from the previous exercise. Click the 
Macros button in the Database window. 

¾ Click the New button to create a new macro. If necessary, click the Maximize button so 
that the Macro window takes the entire screen. 

¾ Click the drop-down arrow to display the available macro actions. Scroll until you can 
select Maximize. (There are no arguments for this action.) 

¾ Click the Action box on the second line, click the drop-down arrow to display the macro 
actions, then scroll until you can click the OpenForm action. Click the text box for the 
Form Name argument in the lower section of the Macro window. 

¾ Click the drop-down arrow to display the list of existing forms and select Switchboard 
(the form you created in the previous exercise). 

¾ Click the Save button to display the Save As dialog box in Figure 1. Type AutoExec as the 
macro name and click OK. Click the Run button to run the macro and open the 
switchboard. 

¾ Close the switchboard. Close the AutoExec macro. 

 
Figure 1 

 
STEP 2:    Create the Prototype Macro 

¾ You should be back in the Database window, which should display the name of the 
AutoExec macro. Click the New button to create a second macro. 

¾ Type Ms (the first two letters in the MsgBox action), then press enter to accept this action. 
Enter the comment shown in Figure 2. 

¾ Click the text box for the Message argument, then press Shift+F2 to display the zoom box 
so that you can see the contents of your entire message. Enter the message “The object 
will be implemented in the next version. In the meantime, you can gain an 
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appreciation for the "look an feel" of the system by stepping through the various 
commands on the switchboard” in Figure 2. Click OK. 

¾ Click the text box for the Type argument, click the drop-down arrow to display the list of 
message types, and select Information. 

¾ Click in the text box for the Title argument, and enter "Under Development". 

¾ Click the Run button to test the macro. You will see a message indicating that you have to 
save the macro. Click Yes to save the macro, type Prototype as the name of the macro, 
and click OK. 

¾ You will see a dialog box containing the message you just created. Click OK. Close the 
macro. 

 
Figure 2 

 
STEP 3:     Create the Close Database Macro 

¾ Click the New button once again to create the third (and last) macro for this exercise. 
Specify the MsgBox action as the first command in the macro. Enter the comment shown in 
Figure 3, and enter the Message “It is not a question of it will happen, but when. Hard 
disks fail, files are lost, and viruses can infect a system. Thus, you are urgent to back 
up your database at the end of every session.” 

¾ Enter an appropriate message that stresses the importance of backup. Select Warning as 
the message type. Enter an appropriate title for the message box. 

¾ Click the Action box on the second line. Type Cl (the first two letters in Close) and press 
enter. Enter the indicated comment as shown in Figure 3. 

¾ Click the text box for the Object Type argument. Click the drop-down arrow and choose 
Form as the Object type. Click the Object Name argument, click the drop-down arrow, 
and choose Switchboard as the Object (form) name. 

¾ Click the Action box on the third line. Type Cl (the first two letters in Close) and press 
enter. Click the comments line for this macro action and enter the comment shown in the 
figure. No arguments are necessary. 

¾ Save the macro as Close Database, then close the macro. If necessary, press the Fll key 
to return to the Database window, where you should see three macros: AutoExec, Close 
Database, and Prototype. 
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Figure 3 

 

STEP 4:    Create the Report Switchboard 
¾ Minimize the Database window to give yourself more room in which to work. Pull down the 

Tools menu, click the Database Utilities command, and choose Switchboard Manager 
to display the Switchboard Manager dialog box. 

¾ Click New. Enter Report Switchboard as the name of the switchboard page. Click OK. 
The Create New dialog box closes and the Report Switchboard page appears in the 
Switchboard Manager dialog box. 

¾ Select the Report Switchboard, click Edit to open the Edit Switchboard Page dialog box. 
Click New to open the Edit Switchboard Item dialog box. 

¾ Add the first switchboard item. Click in the Text list box and type Report 1 as shown in 
Figure 4. 

¾ Press the Tab key to move to the Command list box and type the Run M (the first several 
letters in Run Macro). Press Tab to move to the Macro list box and type P (the first letter in 
the macro name, "Prototype"). 

¾ Click OK to create the switchboard item. The Edit Switchboard Item dialog box closes and  
Report 1appears on the Report Switchboard page. 

¾ Add Report 2 as the next switchboard item. Specify the Run macro command and choose 
AutoExec as the macro.  

¾ Add an additional item that will return the user to the main switchboard. Click New to open 
the Edit Switchboard Item dialog box. Click in the Text list box and type "&Return to Main 
Menu..." 

¾ Press the Tab key to move to the Command list box, where the Go to Switchboard 
command is entered by default. Press the Tab key to move to the Switchboard list box, and 
type M (the first letter in the "Main Switchboard"). Click OK to create the switchboard item. 
Close the Edit Switchboard Page. 
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Figure 4 

 

STEP 5:    Modify the Main Switchboard 

¾ Select the Main Switchboard in the Switchboard Manager dialog box, click the Edit button 
to open the Edit Switchboard Page dialog box, then click New to open the Edit Switchboard 
Item dialog box as shown in Figure 5. 

¾ Add a new switchboard item to open the Report Switchboard. Click in the Text list box and 
type "&Report Menu ...", the name of the command as it will appear in the switchboard. 

¾ Press the Tab key to move to the Command list box, where "Go to Switchboard" is already 
entered, then press the Tab key a second time to move to the Switchboard list box. Type R 
(the first letter in the "Report Switchboard"). Click OK to create the switchboard item. 

¾ The Edit Switchboard Item dialog box closes and "&Report Menu" appears on the main 
switchboard. 

¾ The main switchboard needs one last command to close the database. Thus, click New to 
open the Edit Switchboard Item dialog box. Type &Exit as the name of the command. 

¾ Press the Tab key to move to the Command list box and type R (the first letter in "Run 
Macro"). Press the Tab key a second time to move to the Macro list box, and type C (the 
first letter in the "Close Database" macro). Click OK to create the switchboard item. 

¾ The main switchboard should contain six items— &About Sports, &Players, &Coaches, and 
&Teams from the first exercise, and &Report Menu and &Exit from this exercise. 

¾ Close the Edit Switchboard Page dialog box. Close the Switchboard Manager. 
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Figure 5 

 
STEP 6:    Test the Main Switchboard 

¾ Click the Restore button in the Database window to view the objects in the database, click 
the Forms button, then double click the Switchboard form to open (Figure 6). 

¾ Click the Exit button (or use the Alt+E shortcut). 

¾ You should see an informational message similar to the one shown in the figure. (The 
message is displayed by the MsgBox action in the Close Database macro.) 

¾ Click OK to accept the message. The Close Database macro then closes the database. 

¾ Pull down the File menu, then click Sports Objects from the list of recently opened 
databases. The AutoExec macro executes automatically, maximizes the current window, 
and displays the main switchboard. 

 
Figure 6 
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STEP 7:    Test the Report Switchboard 

¾ Click the Report Menu button (or use the Alt+R keyboard shortcut) on the main 
switchboard to display the Report switchboard in Figure 7. 

¾ Click the buttons for Report 1, Report 2.   

¾ Click the Return to Main Menu button to exit the Report Menu and return to the main 
switchboard. 

¾ To continue working, click the Close button on the title bar (or pull down the File menu 
and click the Close command) to close the form and continue working on this database. 
(You should not click the Exit command button as that would close the database.) You 
should be back in the Database window, where you can continue with the next hands-on 
exercise. 

¾ To close the database, click the Exit button (or use the Alt+E shortcut). 

¾ Either way, you have demonstrated the "look and feel" of the system to the extent that you 
can step through the various menus. Good work. 

 

 
Figure 7 
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